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Introduction

Form MSA-1579 (Rev 9-95) must be used by all Long Term Care nursing facilities and information reported must conform to the requirements and principles set forth in the Provider Reimbursement Manual, Part I (CMS Pub. 15-1), except as provided under the Michigan Medical Assistance State Plan and Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix and Program Bulletins for allowable costs.

Facilities claiming home office costs must submit a Michigan Electronic Home Office Cost Statement (Form MSA-1578) for chain operations.  A chain operation consists of a group of two or more health care facilities or at least one health care facility and any other business or entity, which are owned, leased, or through any other device controlled by one organization.  The home office cost statement form and related instructions can be obtained from the Financial Operations Administration, LTC Reimbursement and Audit Division, LTC Reimbursement and Rate Setting Section if the home office has not previously received the forms.

The completion of all statistical and financial information in the “cost report” forms must be factual and based upon readily available, reliable, and auditable records of the facility.  Generally accepted accounting principles must be followed by providers of care under the Medical Assistance Program.  The accrual method of accounting is mandated for all providers.  

Appropriate audits, utilizing generally accepted auditing standards, will be conducted by the Department to verify accuracy and reasonableness of information and cost contained in all financial and statistical reports.  The Michigan Medicaid State Plan provides that Long Term Care’s audit objectives are limited to ensuring that expenses attributable to allowable items of cost were accurately reported in accordance with Medicaid principles and guidelines.

Cost Report Versions

Due to changes in the Medicaid Program reimbursement policies, different versions of the electronic cost reporting templates may become necessary.  
To determine if you have the latest updated cost report application file, when opening the cost report application, select “Help” and then select “About”.  Verify that the “Support Tables Effective” date is within the last 60 days.  The support tables will be updated between the 20th and 30th of every other month (January, March, May, July, September, November).
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Installing the Electronic Cost Report

The Medicaid Electronic Cost Report Application software is obtained by downloading the appropriate installation file (“Provider Cost Report Full Install.zip” or “Provider Cost Report Update.zip”) through File Transfer.  It will only be necessary to install the “Provider Cost Report Full Install.zip” file before completing the fiscal year ending 2016 cost reporting periods.  Subsequently it will be necessary to install the “Provider Cost Report Update.zip” file in order to update the various Support Tables embedded within the application software.

Both of the above application software files are available in the File Transfer Area “LTC RARSS PR 00001 – 1111111111 MDHHS Administrative Services”.  Due to size constraints the “Full Install.zip” file will not be available on the Department’s website.  The semi – monthly “Update.zip” file will also be available on the Department’s website to download.  

Follow the “Provider Cost Report Installation Instructions” (a separate WORD document) located in the File Transfer Area at “LTC RARSS PR 00001 – 1111111111 MDHHS Administrative Services” and on the Department’s website to install the cost report software.

Click on the following link to access the semi – monthly software update file and the installation instructions:

http://www.michigan.gov/mdhhs/0,5885,7-339-71551_2945_42542_42543_42546_42551-20345--,00.html
Using the Electronic Cost Report Application
Recent Changes to the Electronic Cost Report Application
Application and Data Files

The new Electronic Cost Report consists of the Michigan Provider Cost Report application, which is used to create cost report data files.  This is similar to Microsoft Word creating document (.doc) files.  The cost report data file is the file that should be submitted to the Department of Health and Human Services (DHHS).  The cost report data file is generated in the process of completing a cost report using the application; it will have a “.pfcr” (original) or “.pfca” (amended) extension and be named based on the county code, license number and period end date, i.e., “01-401   2016-06-30.pfcr.”
Creating a New Cost Report 


1. With the Michigan Provider Cost Report application open, click on the “File” menu option, then click the “New” command.  You can also click on the [image: image4.png]


icon on the toolbar.  The following screen will appear.
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2. Fill in the County Code, License Number, Period Start Date, and Period End Date for the new cost report, then click OK.

3. The cost report opens with the menu and toolbar displayed below.
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Entering Data

Entries can be made only in the yellow shaded (or lightly shaded on non-color screens) cells.  All information pertaining to a particular item must be entered into a single cell.  Even though the entire text entry cannot be seen on the screen or printed out, use of multiple rows to enter text will cause validation errors.

Cell Validation

For example, on Worksheet A, if there is an attempt for input "N/A" in the Medicare Number, an error message will appear indicating the data must be numeric and input as "12-34567".  If on Worksheet 5, "cents" are attempted to be input, an error message will appear indicating that "only whole numbers" can be entered.
Rounding Standards

All entries should be rounded to nearest whole number, unless specifically instructed on the worksheet.  The electronic cost report will perform all calculation functions and display the results in the appropriate reporting format.

Date and Year Entries

Dates entered into the cost report should be in the format month/day/year (i.e., enter “1/1/16” for “01/01/2016” to appear).  Key encoding of year entries into the cost report should be in four-digit calendar year format (i.e., 1996).

Name Entries

Names of individuals, corporations, management services, and other organizations must be entered into the cost report on all worksheets using identical spelling.  When one individual fulfills several different positions in the operation of the nursing home, his/her name must be identical in all locations on all worksheets.  For example, John Smith is the owner, resident agent, administrator, and provides related party services to a facility.  Using “John Smith” as the owner, “J Smith” as the resident agent, “JB Smith II” as the administrator, and “J B Smith” as the related party is NOT acceptable.  Enter the full name, i.e. “John B Smith II,” in all cells required.  Do not use punctuation marks in the name or use abbreviations in names; exceptions are "INC" or "LLC".  

Copying and Pasting Data

To copy data (especially numerical values) from an excel data source worksheet into a Cost Report Import Template worksheet, the user must use the “Copy” command from the original excel worksheet and use:

1. “Paste Options” | “Values” command to move the data into the Cost Report Import worksheet.  

2.  Use the “Paste” | “Options” | “Match Designation Formatting” command when copying data from non-EXCEL software.

3. Do NOT use the “Paste Special” command, this command will not correctly paste data into the application.
Cost Report Menu Bar
Cost Report Menu

The Cost Report menu has 4 different options, with several commands associated with each menu item.  
Under the “File” menu item, there are the following standard Microsoft commands:

New:
To begin and create a new cost report.
Open:
Allows user to open any previously saved cost report data file, from the directory location the user previously saved the cost report data file.
Save:
Can only be used after first using the “Save As” command and creates the cost report data file.  Must use the “Save” with each subsequent saving of the cost report data file, to the directory location previously selected during the “Save As” command.
Save As:
Must be used for the first time saving of the cost report data file.  Allows user to select the directory location of the cost report data file.
Print:
Only available after user has completed the “Save As” command.  A screen appears that allows the user to select either all worksheets, or one or more individual worksheets to print.
Close:
Closes the cost report data file and returns user to blank cost report application.
Exit:
Exits the cost report application.
Under the “Edit” menu item, there are the following standard Microsoft editing commands:

Cut:
Only available on a cell which already has data in the cell.  MUST double click in the cell for the “Cut” command to become available.
Copy:
Only available on a cell which already has data in the cell.  MUST double click in the cell for the “Copy” command to become available.
Paste:
Available after data has been “Cut” or “Copy”.  Click into any cell to “Paste” data.  
The standard Microsoft keyboard shortcuts for editing will function.  For example:  Ctrl – C to “Copy” and Ctrl – V to “Paste”, will function to copy and move text to and from the cost report input fields.

Under the “Tools” menu item, there are the following commands:

Calculate:
Used to calculate all worksheets within the cost report application.  Will also flow calculations from one worksheet to another.
Validate:
Runs the cost report application “Validation” which is a series of checks and verifications.  Any validation warnings or errors will appear in a grid at the bottom of the page.  Validate MUST be run prior to submission of the cost report.
Print Certification Page:
A shortcut that allows the user to print only the Certification page.
Submit Cost Report:
To be used, after completion of the cost report, “Validation” has been run, and the cost report is ready for submission to the Department.  Creates a data file that will be submitted to the Department.
Import:
Only to be used in conjunction with the “IMPORT” template(s).  See separate document “Import” Instructions for further details.
Export:
Provides a user the ability to “Export” the following schedules into a separate Excel spreadsheet:  WS 1 – Trial Balance; WS D – Detail General Ledge; WS 2 – G and WS 2 – H which can be saved to the directory location selected by the user.

Change Provider and Period End:
To allow the user the ability to change the county code / license number and period end date without losing all data and needing to create a new cost report. 
Under the “Help” menu item there is only one command:

About:
Select this to determine what was the date of the cost report application’s latest “Support Table Update”.

Calculating the Cost Report

Calculations and data flow to subsequent worksheets does not occur until a manual calculation is performed.  This design feature has been made to speed up data input.  The preparer may calculate at any time during cost report completion.

To calculate the cost report, do one of the following:

1. Click on the Calculate command on the Tools menu.

2. Click the Calculate command on the toolbar.

Validating the Cost Report

Validation permits the user to check the acceptability of the cost report.  This Validation check must be run by the provider before submission of the cost report.  The cost report will automatically be recalculated every time the Validation process is run.  The Validation procedure may also be run at any time during completion of the cost report.

To validate a cost report, do one of the following:

1.
Click on the Validate command on the Tools menu.

2.
Click on the Validate button on the toolbar.

When the validation process is finished, the bottom half of the screen will display any validation errors.
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Double-click on a validation error at the bottom of the screen, and the cost report software program will jump to the affected worksheet and field (cell).
Validation errors are marked as either “Error” or “Warning”.  Submission of the cost report with any validation errors marked as “Error” will cause the cost report to be rejected.  “Warning” messages indicate items that may or may not result in the cost report being rejected.
An explanation document must be included with any cost report submitted with an “Error” or “Warning” message(s).  One explanation document listing all “Error” or “Warning” message(s) with the explanation of “why” each message could not be resolved before submitting the cost report.
The list of validation errors can be made taller or shorter, by dragging up or down, the heavy separator bar located just above the “Validation Errors” caption.
Saving a Cost Report

Save a new cost report

When creating a new cost report, and it has not been saved before, the “Save As” command must be used:

1. Click on the File menu, then click the “Save As” command.  The standard Microsoft save screen will appear.
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2. Locate the folder where you want to save the cost report data file, then click the Save button.  The install process creates a “Michigan Provider Cost Report” folder in your “My Documents” folder to use if desired.

Save an existing cost report

After a new cost report has been saved using the Save As command, further changes to the cost report are saved using the Save command.

1. Click on the File menu, then click the Save command. You can also click on the [image: image9.png]


 icon on the toolbar.
Printing a Certification Page

The certification page (Worksheet A) can be printed by:

1. Click Tools, then click “Validation”.  After all “Error” messages have been resolved, continue.

2. Click Tools, then click Print Certification Page...  A report browser will display.  

See “Printing a Cost Report” below for using the report browser to print the certification page.

The electronic cost report data must be submitted using the Department’s File Transfer Application.  Cost reporting files need to be named using the File Transfer naming conventions.  Files names need to begin with Medicaid county code license number, an underscore, the period end date, and a file content suffix.  For example:  the cost report data file should be named:  99-999 YYYY-MM-DD.PFCR; the signed certification page should be named:  99-999_WS A_2012_12_31.pdf; the cost report submission checklist should be named:  99-999_Checklist_2012_12_31.pdf.
When submitting a “Corrected” cost report, the word “Corrected” should be included in the file name.  For example:  the corrected signed certification page should be named:  Corrected_99-999_WS A_2012_12_31.pdf; the corrected cost report submission checklist should be named:  Corrected_99-999_Checklist_2012_12_31.pdf.
	[image: image10.wmf]
	Make sure to print out the entire WSA worksheet, sign, copy the worksheet and submit it with the cost report data file.


Printing a Cost Report

To print a cost report:

1. Click on the File menu, then click the Print command. You can also click on the [image: image11.png]


 icon on the toolbar.  The following screen will appear:
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2. Check the boxes besides the worksheets you want to print.  Click Select All to print all worksheets.

3. Click the Run Report button.  The following report browser window will appear.  This could take a minute or two.  The printed worksheets will not appear here as they will printed.
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4. To see what the worksheets will look like printed out, click the [image: image14.png]


 icon.

5. To send worksheets to the printer, click the [image: image15.png]


 icon.  A Print screen will appear.
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6. Select the printer and set any other print options, then click the Print button.

7. When finished printing, click the [image: image17.png]


 icon to close the report browser above.
A copy of the print formatted worksheets can also be saved to PDF.

1. To create a PDF file click the [image: image18.png]


 icon, then click PDF.  A Save As screen will appear.
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2. Select the folder and file name you want to save the printed worksheets to, then click the Save button.

Submitting the Electronic Cost Report

To submit the electronic cost report data file to LTC Reimbursement and Rate Setting Section (RARSS):

1. Click on the Tools menu, then click the Submit Cost Report command.  The following screen will appear: 
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2. Click “Yes”.  If you do not want to submit the cost report, click “No”.  No further processing will occur.

3. If there are validation errors designated as “Error”, the following screen will appear.  Only click, “Yes” if you want to submit the cost report with errors.  Most likely a cost report submitted with “Error” message(s) will result in the cost report being rejected.  A cost report submitted with “Warning” messages may or may not cause the cost report to be rejected.
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If you do not want to submit the cost report, click “No”.  No further processing will occur.

4. If there are no validation errors, or you click “Yes” above, the standard Microsoft Save As screen will appear.
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5. Locate the folder where you want to save the submitted cost report data file, then click the Save button. 

In addition to the electronic cost data, Medicaid providers are required to file an electronic copy of the Worksheet A, which includes a Certification Statement, which is produced by the electronic cost report application as a separate document.  In signing this report, it must be understood that the administrator/owner or officer takes full responsibility for the factual information presented.  The cost report shall not be considered complete and properly filed unless the report includes the signed certification.
Opening an Existing Cost Report 

1. With the Michigan Provider Cost Report application running click on the “File” menu option, then click the “Open” command.  You can also click the [image: image23.png]


 icon on the toolbar.  The standard Microsoft open file screen will appear.

2. Locate the cost report data file, and then click on it to select it.

3. Click on the “Open” button in the File Open dialog box.

4. The cost report opens with the menu and toolbar displayed above.

5. To create a PDF file click the [image: image24.png]


 icon, then click PDF.  A Save As screen will appear.
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6. Select the folder and file name you want to save the printed worksheets to, then click the Save button.

Completing the Electronic Cost Report Application
Basic Steps

The basic steps for working with the electronic cost report application are as follows:

1. Install the cost report application.

2. Open the cost report application.

3. Enter data, following the Sequence For Completing Form MSA-1579 (Rev 9-95) instructions.

4. Submit the data to RARSS.

When working with the cost report over a period of time, you can save the cost report at any time without performing the Submission process.  Also, once you have saved your cost report data, you can re-load it at any time to work with it (see Opening an Existing Cost Report for more details).

Prior Period Audit Adjustments

The current period cost report must be filed in accordance with prior year(s) audit adjustment determinations for like costs or cost reporting issues per Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix, Section 4.4.  A provider that receives a Preliminary Summary of Audit Adjustments notice, dated at least 60 calendar days prior to the filing of the annual cost report, must include those audit adjustments that are applicable to the current reporting period and the provider is in agreement, in the completion of the current period’s cost report.  A copy of the letter requesting an Area Office Conference, which details those audit adjustments that the provider has requested additional review must be filed with the current period’s cost report, if the provider does not incorporate those audit adjustments into the current period’s cost report filing.  The cost report filing may be subject to rejection, for not incorporating all audit adjustments.
A provider that receives a Final Summary of Audit Adjustments notice, dated at least 60 calendar days prior to the filing of the annual cost report, must include all audit adjustments that are applicable to the current reporting period, in the completion of the current period’s cost report.  A cost report submitted without incorporation of these audit adjustments will be rejected.
Protest Cost Report

An on-going provider may dispute a Medicaid regulatory or policy interpretation related to the completion of their annual Medicaid cost report.  The provider must submit a separate cost report, referred to as a “protest cost report” to establish their reporting of the dispute issue per Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix, Section 4.12.  

The provider must follow all of the instructions for completion and submission of Worksheet A including clicking the “Protest” checkbox.  When the preparer places a checkmark in the box, the words “FILED UNDER PROTEST” will appear under the signature of the Officer or Administrator and the cost report data file will be saved with a “.PFPCR” or “.PFPCA” extension as opposed to a “.PFCR” or “.PFCA” extension.  
The provider must submit a letter, signed by an authorized representative of the provider, with the protest cost report identifying the issue(s) and respective dollar amount(s) for the basis of the protest cost report filing.  

It is not necessary to complete a separate Medicaid Submission Checklist or other attachments (General Ledger, Trial Balance, etc) required with the original cost report filing.

The “Protest” cost report is NOT utilized for rate determination or reimbursement but will provide information for audit consideration relative to the disputed issue(s).  Protest cost report filing is not for general disagreement with promulgated Medicaid policy.  The RARSS will not accept protest cost reports filings that include items considered as disagreement or dissatisfaction with promulgated Medicaid policy.
Sequence For Completing Form MSA-1579 (Rev 9-95)

The following table is a general guideline for the steps to take to complete the Medicaid Electronic Cost Report.  See the following pages for more details concerning the completion of each worksheet in the cost report.

	Step
	Worksheet
	Quick Instructions
	Page

	1. 
	CHECKLIST
	Complete yellow shaded cells.
	12

	2. 
	WS A
	Complete worksheet through “Type of Control” Section.
	12

	3. 
	WS A
	Complete remaining sections of worksheet.
	12

	4. 
	WS B
	Complete the entire worksheet.
	14

	5. 
	WS C
	Answer questions A and B.

Complete the applicable sections.
	16

	6. 
	WS D
	Complete the entire worksheet.
	18

	7. 
	WS 1-A
	Complete the entire worksheet.
	27

	8. 
	WS 1-B
	Complete the entire worksheet.
	27

	9. 
	WS 1-C
	Complete the entire worksheet.
	28

	10. 
	WS 1-D
	Complete the entire worksheet.
	30

	11. 
	WS 1-E-1
	Complete the entire worksheet.
	32

	12. 
	WS 1-E
	Complete the entire worksheet
	32

	13. 
	WS 1-F
	Complete the entire worksheet.
	33

	14. 
	WS 2
	Complete the entire worksheet.
	34

	15. 
	WS 3
	Complete the entire worksheet.
	38

	16. 
	WS 3-A
	Complete the entire worksheet.
	42

	17. 
	WS 4
	Complete the entire worksheet.
	42

	18. 
	WS 3-LESSOR
	Complete the entire worksheet.
	41

	19. 
	WS 5
	Complete the entire worksheet or submit substitute statements.
	43

	20. 
	WS 6
	Complete the entire worksheet.
	43

	21. 
	WS 7
	Complete the entire worksheet.
	44

	22. 
	WS 8
	Complete the entire worksheet.
	46


Individual Worksheet Instructions

Checklist

The purpose of the Checklist worksheet is to identify each worksheet that is being completed or is not applicable as a part of the cost report.  Each worksheet must be marked “Completed” or “Not Applicable” on the upper left side of the worksheet.  This information will automatically flow to the Checklist page.

Provider Facility Section

Enter the facility’s legal name as enrolled in CHAMPS on the first line.  Enter the facility’s name under which the provider commonly does business as enrolled in CHAMPS, on the second line prefaced by “d/b/a”.  Enter the mailing address of the facility in the “street address” box of the Provider Facility as enrolled in CHAMPS. If a “P.O. Box” or “Suite” is also a part of the mailing address, enter this information in the appropriate box.  The telephone and fax numbers, including area code for the facility, must be entered as enrolled in CHAMPS. 

Preparer Section

Enter the name of the individual preparing the cost report in the appropriate box.  If the individual that prepares the cost report does so as a member of an accounting firm, management or consulting firm, or home office, enter the organization’s name in the “name of firm” box.  Separate boxes are provided and must be used to report the street address and if applicable the P.O. Box or Suite for the preparer.  Telephone and fax numbers must include area code.  Enter the preparer’s email address.
Note: 
Address and Names should NOT be all upper case characters.

NOTE:
Preparers completing multiple cost reports may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Preparer”.

Worksheet A

Information and Certification

Federal I.D. Number, Names and Addresses, Provider Numbers and Dates Certified

Enter on appropriate lines: the Federal I.D. number, nursing unit names and exact street address (if different from Checklist Worksheet), dates certified, and Medicare Provider number. 

The following provider type definitions will apply when completing these cost report forms:

· Medicare Only (SNF Unit)

An institution meeting the requirements of Section 1861(j) of the “Social Security Act” and participating in the Medicare Program only.  The facility, or distinct part thereof, is licensed by the Michigan Department Licensing and Regulatory Affairs (LARA), Bureau of Community and Health Systems, Long Term Care Division to provide nursing care.

· Medicaid (NF) (NF/SNF) Routine Care Unit #1 and #2

An institution meeting the requirements of Section 1861 (j) of the “Social Security Act” and participating in the Medicare/Medicaid Program, or federally, state or locally controlled institution approved by the Secretary.  The facility, or distinct part thereof, is licensed by the Bureau of Community and Health Systems to provide nursing care services and enrolled in the Medical Assistance Program under a signed Medical Provider Direct Payment Application/Agreement (MSA-1625).

· Special Care Unit #1

The facility, or distinct part thereof, is licensed by the Bureau of Community and Health Systems to provide special nursing care.  The nursing unit is enrolled in the Medical Assistance Program under a signed Medical Provider Direct Payment Application / Agreement (MSA-1625).  Indicate the type of special nursing services rendered in the name space provided in the space provided on the worksheet (i.e., Ventilator dependent, closed head injury, mental illness, etc.)

· Adult Daycare Program

The facility operations include activities of rendering adult daycare program services.  The facility conducts this activity and maintains distinct services activity cost accounting procedures to identify the cost associated with the provision of the services and maintains statistical records consistent with other nursing services cost centers for purposes of allocation of costs.  Enter the name of the adult daycare program (or facility name if the same as the facility name) on the “Names and Addresses” column cell.

· Home for the Aged

The facility, or distinct part thereof, is licensed by the Department of Licensing and Regulatory Affairs (LARA), Adult Foster Care and Home for Aged Licensing Division to provide Home for the Aged services.
· National Provider Identifier Number

Enter the ten digit National Provider Identifier (NPI) Number for routine care nursing services.  If the nursing facility is participating in the Medicaid Program with distinct part units and if the units have separate NPI numbers, this should be entered on separate lines in this area.  

· Dates Certified

Indicate the time periods within the current reporting period the nursing care services provider was certified for participation in the respective Program(s), (i.e., “10/01/1996 to 09/30/1997”).  The “Dates Certified” for the “Medicare Only (SNF) Unit” relate to the Medicare program certification time periods.  The remaining “Dates Certified” relate to Medicaid program certification.  If the nursing facility conducts an “Adult Daycare Program”, enter the date that the facility began providing these services.

· Medicare Provider Number

Enter the facility’s Medicare Program I.D. number.  The facility number is required for the “Medicare Only (SNF) Unit”.  If the facility participates both in Medicaid and Medicare, the Medicare number must be entered in the respective Medicaid unit line.  Do not make any entry in this cell if the provider does not have a Medicare provider number.

· Type of Control

Select the type of ownership or auspices under which the business is conducted.
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Provider Cost Verification Section

This section will verify that the data on Worksheets 2-G, 2-H, and 7 contained on the provider’s cost report submission agrees to the signed certification page.  If the data on the signed certification page does not agree with the submitted cost report on the worksheet listed above, the cost report will not be accepted, and cost report data file will be returned to the provider.

Cost Report Type

An option button to indicate what type of cost report is being submitted.

Original
Check the button to indicate that the cost report for the reporting period is being submitted for the first time.

Corrected
Check the button to indicate that the previously submitted cost report had been returned by the Medicaid Program Office due to errors that must be corrected by the Provider and is now being resubmitted.

Amended
Check the button to indicate that the cost report submission is subsequent to the "Original" cost report submission and/or corrected submission, which was accepted by the Medicaid Program Office.  This indicator will be used regardless of whether the cost report is an initial filing of an amended report or to correct a previously filed amended report.


Protest
Check the button to indicate that the additional cost report submission is being filed under “Protest”.  The protest cost report preserves the nursing facility claim for the disputed issues that remain under appeal or are subject to an appeal by the nursing facility.  

Certification Statement

The name of the individual signing the certification statement, their title, and the date the individual signs the statement must be input into the electronic cost report file on the line provided.  The signature of the individual signing the statement must be legible.
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Worksheet B

Statistical and Fiscal Data

Part I — Nursing Facility License/Certification and Statistics

Entry of the Nursing Unit data in Part I must be in the same line (row) sequence as was used in Worksheet A (use of Routine Nursing Care Unit #1 on W/S A, also requires the use of Routine Nursing Care Unit #1 on W/S B, etc. for any additional nursing units reported in W/S A).

Type of Certification

Type of certification refers to the level of care for which the nursing beds are certified for participation in the Medicaid Program. In addition to the definition of types in the Worksheet A section above, the following definitions apply:

Non Available Beds

An area of the facility which the provider has made application to and received advance approval from the Medicaid Program for temporary removal of beds from being considered available for patient care.  A facility with non-available beds must report the number of beds information on this line category.  The number of beds identified in the “Total” line must equal the total licensed beds in the facility.

A facility during a renovation project of an entire wing or unit of the facility, and the rooms are deemed “non-inhabitable” for occupancy during the renovation project by the Bureau of Community and Health Systems, Division of Health Facilities and Services, should report the beds in those rooms, during the limited time period of the renovation as “non–available beds” for cost reporting purposes.  The facility must submit a copy of the signed Building Program Agreement notice from the Division of Health Facilities and Services, permitting re–occupancy of the rooms, with the cost report submission and submit a summary schedule of the room numbers, period of time of the rooms being “non–inhabitable” and the square footage associated with the rooms.  It is recommended that the facility provide a copy of the signed Building Program Agreement notice to RARSS, PRIOR to beginning of the renovation project to avoid cost report error message(s) and cost report rejection.

Apartment/Housing Unit

An area of the facility used for individual residences that is supplying minimum services.  It is a revenue producing cost center not shown elsewhere.  Note: Customary rental units where no nursing services are provided should not be included because beginning and ending numbers of beds are not applicable. 

Non-LTC Nursing Services Unit

Areas of the hospital used for non long term care hospital services.  The number of beds in this area must be entered in order to account for all licensed beds in the facility.  This would include the various hospital classified beds.

Licensed Only

Nursing facilities having a distinct part nursing portion of the facility that is licensed only and does not participating in the Medicaid or Medicare Program.  These beds must also be reported as a distinct part nursing unit in the subsequent cost report work sheets as a “licensed only” unit.  The total amounts reported should not exceed the number of licensed beds in the facility.

Beds at Beginning of Fiscal Period

Enter the number of beds available for use by patients at the beginning of the cost reporting period. Enter the number of available beds by each area or component separately licensed in the facility.

If the facility conducts “Adult Daycare Program” activity, enter the number of beds designated for this activity if such designation exists.  These beds are not inclusive in the facility’s licensed bed number for other nursing areas.  If no beds are designated as “Adult Daycare Program” activity, enter zero (0) in the beginning cells.

Beds at End of Fiscal Period

The “Beds at End of Fiscal Period” will be automatically calculated, from selecting the Menu Option “Tools” and “Calculate” from the “Tools” drop down list.  
If the provider had any bed changes during the cost reporting period, “Part II – Other Nursing Facility Data” must be completed prior to calculating the beds at the end of the fiscal period.
Total Bed Days Available

The “Total Bed Days Available” will be automatically calculated, from selecting the Menu Option “Tools” and “Calculate” from the “Tools” drop down list.
A patient day is defined as the period of measurement for lodging (room and board) provided and services rendered to one in-patient between the census taking hour (zero hour at midnight) on two successive days.  In computing patient days, the day of admission is counted but the day of discharge is not.  However, should a patient be admitted and discharged the same day, this period is counted as one patient day.

Where a total “Ban on Admissions” has been imposed by the Bureau of Community and Health Systems during the reporting period, the number of bed days available is limited to the actual inpatient census for each day of the ban time period.  A copy of the Bureau of Community and Health Systems “Ban on Admission” notice and EXCEL spreadsheet must be submitted with the cost report filing.  The spreadsheet must identify: each day during the cost reporting period that the ban is in effect, and the number of residents in the facility on each day.  If the ban is amended to permit limited admissions, contact this office for directions on how to calculate the bed days available.

A “Denial of Payment for New Medicare/Medicaid Admissions” is an action imposed by the Bureau of Community and Health Systems.  The bed is available to admit residents from other payor sources, therefore the bed is included in the bed days available calculation.  The Denial of Payment is Medicaid payment control that will not allow payment for services provided during the denial time period for a resident who is admitted after the effective begin date of the denial on Medicaid payments.  

If the facility conducts “Adult Daycare Program” activity, enter the number of “daycare days” of services rendered during the cost report period.  A “daycare day” is considered to be a day or portion of a day, in which an individual is rendered daycare services in the facility.  Enter the same number in both “days available” and “inpatient days” for this activity.  Enter “0” in the Title XIX data for the “Adult Daycare Program” area.

The policies that must be used for Medicaid purposes for determining patient census are in the Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix, Section 3 – Definitions.

Percent Occupancy 

The percentage of occupancy is the ratio of the total inpatient days to the bed days available during the cost reporting period. The percentage occupancy and 85% occupancy (if applicable) will be automatically calculated.

Inpatient Days — Health Care Programs

· Title XVIII

Title XVIII Integrated Care Days – Enter the patient days statistics that are applicable to Title XVIII (“Integrated Care Medicare Days) which are part of the total statistics in the previous “Total Inpatient Days” column.  Beneficiaries enrolled in the Integrated Care Organizations for days 1 – 90 are considered Integrated Care Medicare Days.  IF a PACE resident is in a NF under a Medicare stay, any NF days for that resident should be reported in this column.
Title XVIII HMO Inpatient Days – Enter the patient days statistics that are applicable to Title XVIII HMO Medicare Advantage Plans which are part of the total statistics in the previous “Total Inpatient Days” column.  Providers participating in the Medicare Program with beneficiaries enrolled in a Medicare Advantage Plan must complete this information.  Enter “0” (zero) if there is no beneficiaries who participated in a Medicare Advantage Plan(s).

Title XVIII Inpatient Days – Enter the patient days statistics that are applicable to Title XVIII (“traditional” Medicare) which are part of the total statistics in the previous “Total Inpatient Days” column.  Providers participating in the Medicare Program must complete this information.  Enter “0” (zero) if there is no participation in the Medicare (“traditional”) Program.

· Title XIX 

Title XIX – Integrated Care Days – Enter the patient days statistics that are applicable to Title XVIII (“Integrated Care Medicaid Days) which are part of the total statistics in the previous “Total Inpatient Days” column.  Beneficiaries enrolled in the Integrated Care Organizations for days 90+ are considered Integrated Care Medicaid Days.  IF a PACE resident is in a NF under a Medicaid stay, any NF days for that resident should be reported in this column.
Title XIX – Inpatient Days – Enter the routine nursing care inpatient days pertaining to Title XIX (Medicaid) Health Care Program.  The Title XIX inpatient days should be reported by the nursing care unit in which the services were provided. 

Title XIX — Special Care Days – Enter the special nursing care inpatient days pertaining to Title XIX (Medicaid) Health Care Program.  Special care days defined - inpatient days rendered under a separate agreement (“Memorandum of Understanding”) between the facility and the Medical Services Administration.  This agreement is patient specific and is for a limited time period. 

Title XIX — Healthy Michigan Program Days – Enter the Healthy Michigan Program days (MAGI = “I”), pertaining to Title XIX (Medicaid) Health Care Program.  The Title XIX Healthy Michigan Program inpatient days should be reported by the nursing care unit in which the services were provided.

Part II — Other Nursing Facility Data

Question 1 must be answered.  Examples of a “yes” would be any licensing, certification or approved unavailable bed changes.  If “yes”, list each change occurring during the cost reporting period on separate lines as provided.  This information is utilized in calculating “Total Bed Days Available” on Part I.  Select from the drop down list in the “Place of Change” column the reference to the nursing units indicated in Part I of this worksheet.  Each separate nursing unit having a change must be reported in separate rows.  Beds “lost” in one unit and “gained” in another unit must be reported as two separate row entries.  A single row entry cannot have beds “gained” and “lost” even if the changes are in the same nursing unit.
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Worksheet C

Ownership Information and Questionnaire

Part A

Proprietorship and partnership entities as indicated in the “Type of Control” section of Worksheet A, must report ownership information in Part A.  Legal name and address of the entity, name of all owners and/or partners and their addresses must be entered.  Enter officer position in the title column, or “owner” or “partner” should be entered if the individual is not an officer.  Ownership percentage entries must be entered as decimal equivalent amounts (e.g. 90% must be entered as .9).  Identify the individuals with the 12 highest ownership interests if more than 12 owners exist. Identify the entities’ resident agent if one exists.  Begin name of owners and/or partners in the first yellow hi-lighted row.  An additional blank row becomes available upon entry of information in each previous row.  All entries will be compared with the Provider’s CHAMPS Provider Enrollment file data.
Part B

All other “Types of Control” as indicated on Worksheet A, report ownership or board member information in Part B.  Legal name and address of the entity, name of all officers and/or board of director members and their addresses must be entered.  If the provider is a long-term care unit of a hospital, the legal name and officers and directors of the hospital should be identified. 

Enter officer position in the title column.  Members of the board of directors, not holding office should be identified as “member” for their title.  Multiple titled individuals should include all applicable titles in the “Title” column.  Begin identifying the names of owners, partners, or board members in the first yellow hi-lighted row.  For voluntary non-profit and government entities, complete all lines in Part B, except “Resident Agent” line and all lines in the area titled “Name of Stockholders Owning at Least 10%”.  

Ownership percentage entries must be entered as decimal equivalent amounts (e.g. 90% must be entered as .9).  If the facility is owned and operated as a corporation, officers, directors and shareholders only need to be identified once in Part B.  Officers and directors owning at least 10% of stock must not be listed in the portion of Part B, titled “Name of Stockholders Owning at Least 10%".  If the entity “Type of Control” on Worksheet A is “Voluntary Non-Profit” or “Government”, percentage of ownership column does not need to be completed.

The name and address of the corporate resident agent must be entered in Part B on the line indicated.  If the Resident Agent is also an officer or shareholder of the company and has a percentage of ownership already identified on a line prior to the “Resident Agent” line, DO NOT again include an amount in the “Pct. of Shares . . .” column.  Identify “0%” in the “Resident Agent” percentage column so that the person’s ownership is not counted twice.  If the “Resident Agent” individual is not listed in the prior lines, then it is proper to identify the person’s percentage of ownership on the “Resident Agent” line.  If the resident agent owns less than 10%, the resident agent is not listed again in the portion of Part B, titled “Name of Stockholders Owning at Least 10%”.  If there are no owners having at least 10%, leave the lower section blank.  All entries will be compared with the Provider’s CHAMPS Provider Enrollment file data.
PART C

Answers to the two questions are required for all providers.

The first question relates to owners and officers receiving compensation directly and/or indirectly from the nursing facility.  The answer to the question is “yes” if either of the following situations exist:

· Owner(s) and/or officers of the nursing facility are employed by the facility, in addition to also being employed by another entity, regardless of whether such entity provides service to the facility;

· Owner(s) and/or officers of the nursing facility are not employed by the facility, however do have ownership, are employed by or have other compensatory affiliation with another entity providing service to the nursing facility.

The existence of second situation described above will require further disclosure of related entity purchases on Worksheet 1-C of the cost report.

Part D

If either question in Part C is “yes”, further disclosure of the data is required in Part D.

The second question relates to owners and officers of the nursing facility also having ownership interests or control in any other long term care facility (ies).  If additional ownership(s) exists, the related facilities must be identified in Part D.  

Nursing homes operated as part of a chain organization must first individually list those facilities located in Michigan.  List all the facilities located in Michigan, and the number of facilities owned and/or operated in other states along with the State name.
· Facility Name/Entity – The “d/b/a” (doing business as) name of the facility should be input for all facilities located in Michigan.  For multi- state organizations listing their non-Michigan facilities, enter the word “Various”.
· Location (City) - The city the facility is located in should be input for all facilities located in Michigan.  For multi-state organizations listing their non-Michigan facilities, enter the word “Various”.
· Location (State) - The two digit postal abbreviation code should be used for all entries.  Enter the appropriate two digit postal abbreviation code from the drop down list provided.
· Relationship - A brief description of the legal relationship between the provider and related entity listed. 

· Medicaid Long Term Care - This checkbox is required to be checked, if the component listed, is a Michigan Long Term Care Provider.
· County Code – The two digit county code is entered for each individual Michigan facility listed (for example “01”).  For each related Michigan non nursing facility listed enter “00” for the county code.  For multi – state organizations, the county code entered should also be “00”.

· License No. – The license number is entered for each individual Michigan facility listed (for example “300” or “400” or “800”).  For each related Michigan non-nursing facility listed enter “001”.  Report information applicable to each individual state on separate lines.  Enter the number of related non – Michigan facilities in each individual state (for example “009” or “020” or “100”). 
NOTE:
Preparers completing multiple cost reports may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Related Facilities or Entities”.
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Mapping of Provider General Ledge to Cost Report

General Ledger Account Number:
Enter the Provider’s Detail General Ledger Account Number.  Account Number will automatically flow to Worksheet 1, “Provider’s Corresponding Account Number”.
General Ledger Account Name: 
Enter the Provider’s Detail General Ledger Account Name.
Cost Center: 
Select the appropriate “Cost Center” from the drop down listing of available “Cost Centers”.  The “Cost Center” must be selected prior to selection of the “Account”
Account: 
Select the appropriate “Account from drop down listing of available “Accounts” applicable to the “Cost Center” selected previously.
ACCOUNT NUMBER NOTE:
When entering an “Account” number for provider purchased services from an outside supplier, as an alternative to employing base cost facility personnel to perform such services is eligible to apportion the contract services costs between base and support, utilize the following “Account” numbers.  The total cost of services will be reclassified into base and support costs for proper reporting purposes using the Medicaid policy reporting percentage identified on this line.

Laundry
Account Number:
253


Dietary
Account Number:
308


Nursing Administration
Account Number:
340


Social Services
Account Number:
441


Diversional Therapy
Account Number:
469

Amount 
Enter the account balance as of the end of the cost reporting period.  Amounts must be entered as a whole number.
NOTE:
Preparers may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import General Ledger Entries”.
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Worksheet 1

Statement of Revenues and Expenses

Standardized accounting procedures are required for management information, budgeting, responsible reporting and internal control.  Uniform classification of accounting input is also necessary to obtain valid statistical data for uniform reporting.

Worksheet 1 is a statement of revenues and expenses incurred by the facility for the cost reporting period.  The Medicaid reimbursement methodology requires separate identification of Plant, Base and Support costs.  The cost reporting worksheets provide for the reporting of costs in these separate classifications.  The “Plant/Base/Support” reference column is included in Worksheet 1 that cannot be changed. 

Base/Support Ratio for Contract Services

The “Contractor Services - Base” account amount must only include those specific purchased services costs identified as 100% base cost (see section Worksheet D Base/Support/Plant Classes).

A provider purchasing services from an outside supplier, as an alternative to employing base cost facility personnel to perform such services must apportion the contract services costs between base and support.  The total cost of services will be reclassified into base and support costs for proper reporting purposes using the Medicaid policy reporting percentage identified on this line.

Cost Center Descriptions

Worksheet 1 mainly pertains to the reporting of general services costs properly classified to plant, base and support costs elements reimbursable under the program.  It provides for recording the Trial Balance of expense accounts from the provider’s accounting books and records.  The cost centers on this worksheet are listed in a manner which facilitates the transfer of various cost center data to the cost finding worksheets.  Where the cost elements of a cost center are separately maintained on the provider’s books, a reconciliation of the costs per accounting books and records to those on this worksheet must be maintained by the provider.
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Revenues

Routine Services Revenue Section and Ancillary Services Section provide several accounts for providers to enter revenues received from the appropriate payor source.  Revenues must be reported on the separate payor source lines as indicated, and must not be combined or consolidated for reporting.  
Separate accounts are provided for reported revenue received related to the Quality Assurance Supplement – Long Term Care, Quality Measure Initiative – Long Term Care payments (applicable to nursing facilities or county medical care facilities or hospital long term care units) and hospital Quality Assurance Supplement payments.  The hospital Quality Assurance Supplement payments would include, but not limited to Medicaid Access to Care Initiative (MACI) and Disproportionate Share Hospital (DSH) payments.  Payments whether monthly, quarterly, or annual and reconciliations are to be reported on the appropriate line(s).
Base/Support/Plant Classes

Cost descriptions are guideline to provide consistency in Provider cost reporting for Medicaid cost report filing and identification of reimbursement classifications for specific cost categories.  Reimbursable cost classifications are identified for the individual cost elements in accordance with the provisions of the Medicaid State Plan and Policy Manual.  The Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix, Section 14 provides the definitions of the Medicaid Program cost classifications for reimbursement.

Plant 1, 2 and 3

· Plant 1

Depreciation of building and improvement costs which are normally allocated on square footage basis only.

· Plant 2

Depreciation of equipment/moveable including furniture and fixtures and transportation equipment, which are normally allocated based on square footage or dollar value.

· Plant 3

Interest expense, property taxes, allowable lease rental components and interest related amortization normally allocated based on square footage.

Provider’s Trial Balance

Expenses listed in this column must be in accordance with the provider’s accounting books and records detailed among plant, base and support costs.  Select the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list.  The total in this column must equal the total of expenses in the provider’s detail general ledger (Worksheet D).  
Minor Equipment

Several cost centers in the worksheet have the accounts titled “Minor Equipment - Less Than $5,000” and “Minor Equipment - More Than $5,000”.  The following guidelines should be used in reporting the costs in these accounts.

Minor Equipment – More Than $5,000.  If a depreciable asset has at the time of its acquisition an estimated useful life of at least 2 years and a historical cost of at least $5,000, its cost must be capitalized and written off ratably over the estimated useful life of the asset using one of the approved methods of depreciation.  If the Provider has expensed capital asset costs in excess of the minimum amount allowed for Program minor equipment expense, this expense must be separately reported in this account and will be removed from current year allowable cost.  See cost reporting instruction, “Capital Asset Values” for related cost reporting instructions.

Minor Equipment – Less Than $5,000.  If a depreciable asset has a historical cost of less than $5,000, or if the asset has a useful life of less than 2 years, its cost is allowable in the year it is acquired, as long as it was also expensed for financial statement purposes.  If the costs was capitalized on the financial statements, then it must be reported on Worksheet 3.  The cost of asset acquisition meeting this requirement is reported in this account.  The cost of asset acquisition meeting this requirement is reported in this account.

The provider may utilize a capitalization policy with lower minimum criteria, but under no circumstances may the above minimum limits be exceeded.  For example, a provider may elect to capitalize all assets with an estimated useful life of at least 18 months and a historical cost of at least $4,000.  However, it may not elect to capitalize only those assets with a useful life of at least 3 years and a historical cost of more than $6,000. 

When items are purchased as an integrated system, all items must be considered as a single asset when applying the capitalization threshold.  Items that have a stand-alone functional capability may be considered on an item-by-item basis.  For example, an integrated system of office furniture (interlocking panels, desktops that are supported by locking into panels) must be considered as a single asset when applying the threshold.  Stand alone office furniture (e.g., chairs, and freestanding desks) will be considered on an item-by-item basis.

Plant Costs

Depreciation, interest, property taxes, leases, and amortization treated as interest are reported as plant costs.

If the provider directly identifies plant costs to specific cost centers, these costs should be reported in the appropriate cost centers.  This identification will be directly identified plant cost in subsequent worksheets for cost allocation.  The provider must assure that there is not an unreasonable or inequitable allocation of total costs not directly identified.

Account Reference #125 is for recording Interest Expense from the Mortgage and Bonds related to the current ownership’s acquisition of the facility.  Account Reference #126 is for recording all Other Interest Expense incurred by the facility.  In the case of a refinancing of the original acquisition loan, the provider must identify that portion of the new loan interest expense attributable to the portion of the loan that is the original acquisition loan amortization and report that Interest Expense in Account Reference #125.  The difference between the interest expense attributed to the original acquisition principle balances and the refinanced loan’s total interest expense and all other interest expense would be reported in Account Reference #126.

Account Reference #118 through 123 will be entered as the result of completing W/S 1-D. Account Reference #130 through 132 will be entered as the result of completing W/S 3.  Items directly identified to a specific cost center should be posted on W/S 1 and not on W/S 3.

Employee Health and Welfare

This cost center includes all fringe benefits such as employer contributions to FICA, FUTA, MESC, employee life and health insurance, workers compensation, retirement, physicals and all other insurance provided to employees as fringe benefits.

Expenses related to payroll taxes and employee health and welfare are classified by the reference “B/S”.  Since the Medicaid Program classifies certain salaries and wages as “Base” costs, and other salaries and wages as “Support” costs, the related payroll taxes and employee health and welfare expenses will also be separated to “Base” and “Support” as appropriate.

If the facility’s accounting records separately reflect the payroll taxes and employee health and welfare expenses for “Base” and “Support” personnel, the individual cost center accounts should be used in the Worksheet 1.

If the facility’s accounting records do not separately reflect the payroll taxes and employee health and welfare expenses for “Base” and “Support” personnel, by cost center identification, the total amount of these costs must be reported on W/S 1 in the Employee Health and Welfare cost center, “Account Reference #” lines 139 through 146.  The necessary reclassification of these costs based upon payroll distribution will be automatically completed on W/S 1-G.

If the provider has a more equitable allocation method to allocate these costs than based upon payroll distribution, the allocation must be reflected as a cost reclassification on Worksheet 1-A.  The balance of the “Account Reference #” lines 139 through 141 and 143 through 146 must be zero after this reclassification.  Worksheet 1-G must not be used to re-class these costs.

Account Reference # 142 is for recording the total Worker’s Compensation premium costs where the provider does not have accountings records that separately identify this cost by individual cost center.  Worker’s Compensation cost will be allocated on Worksheet 2 based upon payroll distribution.  If a direct identification of Worker’s Compensation premium costs by individual cost center is available, the individual cost center Workers Compensation account must be used; individual cost centers without a Workers Compensation account should use the Employee Benefits account.

Administrative and General

This cost center includes but is not limited to office supplies, printing, postage, legal and accounting, telephone, travel, advertising, public relations, general insurance and other such support materials incurred in the general administrative services of the facility.

Account Reference #154 through 156 will be automatically entered as a result of completion of W/S 1-E-1.  Account Reference #157 will be automatically entered as a result of completion of W/S 1-E.

The monthly Quality Assurance Assessment fees billed to the long term care nursing facility (nursing home, or county medical care facility, or hospital long term care unit) for the calendar months included in the cost reporting period must be reported as an expense in the facility’s financial records and reported in the cost report’s Account 203.  Quality Assurance Assessment fees billed to the hospital (including MACI, DSH) for the calendar months included in the cost reporting period must be reported as an expense in the facility’s financial records and reported in the cost report’s Account 207.  The monthly Quality Measure Initiative fees billed to the long term care facility for the calendar months included in the cost reporting must be reported as an expense in the facility’s financial records and reported in the cost report’s Account 208.  If a change of ownership occurs during a calendar month and both nursing facility entities prorate the assessment fee between the entities, supporting documentation must be submitted by each entity when filing their respective cost report.  The supporting documentation must include entity sales document showing the proration.

Account Reference 204 – Provider Donation for Outstationed Workers would be utilized by the nursing facility that has a signed agreement with the Department of Health and Human Services (DHHS) for the salary costs of an on–site eligibility specialist worker.  The costs reported for the worker, cannot exceed the amount stated in the contract agreement.  A copy of the signed agreement must be submitted with the facility’s cost report.  If the nursing facility has entered into an agreement(s) with other nursing facility(ies), to “share” the outstationed worker services, an individual Worksheet 1–B adjustment must be made for the amount of services purchased by each facility.  Documentation must be submitted by the facility that entered into the agreement with DHHS, that details the facility(ies) using the outstationed worker services, and the amount of services purchased by each facility.

Plant Operation and Maintenance 

This cost center contains cost of ordinary repairs and maintenance, maintenance supplies and materials, maintenance service contracts for equipment, elevators, carpet cleaning, other service contracts such as snow and trash removal, etc.  Maintenance and repair costs that are applicable to the housekeeping, dietary, laundry and other cost centers but not readily identified in the provider’s accounting books and records, may be included in this cost center.  See the instructions on Worksheet 2 for special note on statistics for Worksheet 2.

Account Reference #209 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Utilities

This cost center includes utilities, i.e., heat, fuel, electricity, water.  See the instructions on Worksheet 2 for special note on statistics for Worksheet 2. 

Laundry

This cost center includes laundry and linen supplies, repairs of laundry equipment, outside laundry services, linen and bedding.  If any miscellaneous base costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #266.

Account Reference #246 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Housekeeping

This cost center includes housekeeping supplies, services, housekeeping equipment repair, outside housekeeping services, etc.

Account Reference #276 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Dietary

This cost center contains all supplies, disposable tableware, raw food, repair of equipment and dietitian contractual services, etc., including the costs of the separately operated cafeteria for employees and/or guests.  For statistical purposes, a Meal Served equals either a patient tray or a cafeteria purchase.
If any miscellaneous base costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #321.  If any miscellaneous support costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #322.

Account Reference #301 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Nursing Administration

This cost center normally should include only the cost of nursing administration, including the wages, benefits, and payroll taxes for at least 12 hours of In-service training per aide employed and associated In–service trainer wages, benefits and payroll taxes that relates to this training.  The salary cost of direct nursing services, including the salary cost of nurses who render direct services in more than one patient care area, should be directly assigned to the various patient care cost centers in which services were rendered.

If any miscellaneous base costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #353.  If any miscellaneous support costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #354.

Account Reference #331 will be automatically entered as a result of completion of W/S 1-E-1.  Account Reference #332 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Central Supplies

All supplies and materials, not included anywhere else, should be included in this cost center.

Account Reference #360 will be automatically entered as a result of completion of W/S 1-E

Medical Supplies

Chargeable and non-chargeable supplies should be reported in this cost center.  Chargeable supplies (those items for which a separate billing is submitted to the beneficiary or other third party) should be reclassified to “Medical supplies charged to patients”, Account Reference #s 641 through 649.

Account Reference #384 will be automatically entered as a result of completion of W/S 1-E.

Medical Records Library

This cost center reflects the cost of medical records activity.  All long term care providers are expected to record expenses associated with this activity in this cost center.
Account Reference #408 through 409 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Social Services

This cost center reflects the costs of maintaining social services activity and case managers.

If any miscellaneous base costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #451.  If any miscellaneous support costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #452.

Account Reference #433 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Diversional Therapy Activities

All diversional therapy activities expenses should be included in this cost center.

If any miscellaneous base costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #479.  If any miscellaneous support costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #480.

Account Reference #461 will be automatically entered as a result of completion of W/S 1-E-1 and W/S 1-E.

Radiology, Laboratory, Intravenous Therapy, Inhalation Therapy (Oxygen), Physical Therapy, Speech Therapy, Occupational Therapy, Electroencephalography, Medical Supplies Charged to Patient, Pharmacy Physician Services

These are ancillary cost centers. Salaries and wages will be automatically entered as a result of completion of W/S 1-E.

Medicare SNF Unit, Medicaid Routine Care Unit #1 and #2, Medicaid Special Care Unit #1 and #2, Home for Aged Unit, Non-LTC Apartment/Housing Unit, Non-Medicare and Non-Medicaid Licensed Only, and Non-LTC Nursing Services

These were previously defined. Salaries and wages will be automatically entered as a result of completion of W/S 1-E.

If any miscellaneous base costs cannot be identified with any other Account Reference #, the amount can be entered on the Miscellaneous - Base line.  If any miscellaneous support costs cannot be identified with any other Account Reference #, the amount can be entered on the Miscellaneous - Support line.

Non-Available Beds

This cost center is available for the step-down and any specifically identified cost.

Nurse Aide Training & Testing — LTC

· Training Program Approval Requirement

Only costs incurred relative to a Bureau of Community and Health Systems approved Nurse Aide Training Program may be claimed on this schedule.  An approved program may be conducted by the provider facility or by a separate entity from the provider.

· Accounting Records and Allowable Costs

Accounting records must be maintained to document the allowable costs incurred in providing the training and testing.  Allowable costs must be determined in accordance with the requirements and principles set forth in the Provider Reimbursement Manual, Part I (-CMS Pub. 15-1), except as provided under the Michigan Medical Assistance State Plan and Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix and Program Bulletins.

Training and testing program costs claimed for services and supplies furnished to or purchased by the facility from organizations related to the provider by common ownership or control must adhere to the related party allowable cost principles.  Expenses for such transactions should not exceed expenses for like items or services in an arms-length transaction with other non-related organizations, or the cost to the related organization, whichever is lower.  Cost reporting of related party transactions must be coordinated with the reporting of cost adjustments on Worksheet 1-C related party expenses.

Administrative overhead costs and space costs in nursing facilities conducting in-house training are not considered training and testing program costs.  The costs reported must be specifically incurred in conducting the approved nurse aide training and testing program. 

Supporting accounting records such as class attendance rosters or training participation logs, purchase orders, vendor invoices, contracts, documentation verifying amounts reimbursed to employees for approved training program expense incurred by the employee prior to employment at the facility (canceled check, training program receipt), etc. must be maintained for audit purposes.  Supporting materials should be readily identifiable as training related cost documentation and must indicate the type of training involved.
The Department has posted on the Section’s webpage, a Frequently Asked Questions and Answers document which may provide additional guidance regarding Nurse Aide Training and Testing program reportable expenses.
If the facility maintains separate cost center reporting for the training program, enter the appropriate costs as identified.

Nurse Aide Training and Testing Cost Definitions:

1. Facility Training Staff

Payroll related costs for facility employees, incurred for the approved program direct training time or nurse aide training program preparation time. 

2. Nurse Aide Training Consultants

Costs incurred for non-facility staff engaged to provide instruction or consultation for the facility’s approved nurse aide training program.

3. Student Staff

Payroll costs for facility employees incurred while the student is actually engaged in the approved training program or traveling to and from the off-site approved training location, or engaged in off-site testing or traveling to and from the off-site testing location.

4. Training Program Supplies

Cost incurred for supplies and materials used in conducting an approved training program.

5. Training Program Transportation

Travel or transportation cost incurred by facility staff in conducting approved training program activity and testing, or for off-site nurse aide training and testing.  Identify costs separately for training and student staff.

6. Outside Contracted Approved Nurse Aide Training Program

a. Paid Directly By Facility

Costs incurred to obtain nurse aide training through an outside entity approved training program.  Payment for subject training is made directly from the nursing facility to the training entity and the nurse aide trainees are employed by the nursing facility.

b. Reimbursed To Employee Staff

Costs incurred to reimburse a facility employee who had personally paid for approved nurse aide training program participation prior to becoming an employee at the facility.  Reasonable and necessary expenses incurred by the prospective employee through participation and completion of a Bureau of Community and Health Systems approved training program, for which the aide has made payment, are eligible for remuneration.  Only cost of tuition and books are reimbursed.  The aide must be hired by a facility within 12 months after incurring this expense.  The facility must obtain receipts and retain documentation from the employee to verify the expense.

7. Nurse Aide Testing Fees

a.
Paid Directly By Facility

Cost incurred for State-run testing.  Payment for subject testing fees is made directly from the nursing facility to the testing authority for aides employed at the facility.

b.
Reimbursed To Employee Staff

Cost incurred to reimburse a facility employee who had personally paid for State-run testing prior to becoming an employee at the facility.  The aide must be hired by a facility within 12 months after paying the testing fee.  The facility must obtain receipt and retain documentation from the employee to verify the expense.

8. Miscellaneous

Cost incurred that are not classified in the identified cost categories.

Rental costs for space located off-site of the facility are reimbursable under training and testing only if the space is used solely for the training and testing program.  Space costs not meeting this requirement are reimbursable within the plant cost component of Michigan’s prospective reimbursement system.  Reasonable rental expense for training equipment necessary to the approved training program is an eligible cost.

The detail listing of these expenditures must be reported in Worksheet 8, Miscellaneous. Refer to the Worksheet 8 instructions.

Account Reference #964, Miscellaneous, will be automatically entered from data reported on W/S 8.

Note:
If the facility does not maintain separate cost center reporting, appropriate cost reclassifications must be made on Worksheet 1-A for Account Reference #951, and #955 - #964.

Special Dietary

Special dietary reimbursement outside the routine nursing care per diem for special dietary needs of religious non-profit nursing facilities requires completion of account reference #970 through #991.

Note:
Account Reference # 970 will be automatically entered as a result of completion of W/S 1-E for those providers that directly identify salary costs.  If the provider does not directly identify salary costs on the Worksheet 1-E, a reclassification must be made on Worksheet 1-A for the salary and wages of special dietary staff.

Note:
 A reclassification of related payroll taxes and fringe benefits must be made on Worksheet 1-A, if the provider directly identifies payroll taxes and fringe benefits by cost center.  Reclassification of related payroll taxes and fringe benefits will automatically be calculated on Worksheet 1-G for providers that do not directly identify payroll taxes and fringe benefits. (see section Worksheet D Employee Health and Welfare)

If any miscellaneous base costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #990.  If any miscellaneous support costs cannot be identified with any other Account Reference #, the amount can be entered on Account Reference #991.

If the facility does not maintain separate cost center reporting, appropriate cost reclassifications must be made on Worksheet 1-A.

Beauty & Barber Shop, Gift, Flower, Coffee Shop & Canteen, Physician’s Private Office, Non-paid Workers, & Other

These cost centers are available for the step-down and any specifically identified costs, including nonreimbursable costs that do not have a specific cost center already assigned, such as a Marketing Department.
Reclass

There are no direct entries to this column. All entries to this column will automatically flow from subsequent worksheets.

Adjustments

There are no direct entries to this column. All entries to this column will automatically flow from subsequent worksheets.

Medicaid Trial Balance

There are no direct entries to this column.  The column entries are automatically entered as the result of all of the provider's trial balance adjustments and reclassifications.  The Medicaid trial balance amounts will be automatically carried forward to subsequent worksheets for the allocation process.

Worksheet 1-A

General Reclassifications

The purpose of this worksheet is to identify cost reclassifications in the reclass column on Worksheet 1, of certain amounts to effect proper cost classification for Medicaid reimbursement and cost allocation under cost finding. 

A reclassification will transfer the specified cost from one designated Account Reference # to another designated Account Reference #.  The first seven lines of Worksheet 1-A are reserved for information posting from W/S 1-D. Entries in the “Explanation of Reclassification” column can be of any length.  Although it may not print, the information is available electronically. 

All reclassifications are to be assigned a letter in the Code column.  Start with adjustment “b” on the first shaded line.  The cost center must be entered in the Cost Center column and the Account Reference # from within that cost center must be entered in the Account Reference # column as shown on the first seven lines.  
All reclassifications must be reported on one line.  Each line / row increase must equal that line’s decrease.  Multiple line / row reclassifications to a single line reclassification are not allowed.
Reclassify costs reported on Worksheet 1 to reflect proper classification per Medicaid reimbursement policy.  This action is necessary where a certain cost has been reported in an inappropriate cost center or Account Reference # on Worksheet 1, Provider Trial Balance column.

NOTE:
Preparers completing multiple cost reports with the same reclassification may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Reclassifications”.
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Worksheet 1-B

Adjustments to Expenses

Provider Prepared Adjustments

Worksheet 1-B provides for the adjustments to the expenses listed on Worksheet 1.  These adjustments, which are required under the Medicaid Principles of Reimbursement, are to be made on the basis of “cost”, or “amount received” (revenue) only if the cost (including direct cost and all applicable overhead) cannot be determined.  If the total direct and indirect cost can be determined, enter the “cost”.  Once an adjustment to an expense is made on the basis of “cost”, the provider cannot make the required adjustment to the expense on the basis of “revenue” in future cost reporting periods.  The following symbols must be entered in column 1 to indicate the basis for adjustments: “A” for cost; and “B” for amount received.  Line descriptions indicate the more common activities, which affect allowable costs, or results in costs incurred for reasons other than patient care and thus require adjustments.

Types of items to be entered on Worksheet 1-B are: (1) those needed to adjust expenses to reflect actual expenses incurred; (2) those items which constitute recovery of expense through sales, charges, fees, grants, gifts, etc.; (3) those items needed to adjust expenses in accordance with the Medicaid Principles of Reimbursement; and (4) those items which are provided for separately in the cost apportionment process.

Where an adjustment to an expense affects more than one cost center, the provider must record the adjustment to each cost center on a separate line on Worksheet 1-B.  Yellow shaded lines may be used for such adjustments.  The number entry in the amount column can be either plus or minus.  Minus amounts are displayed in ( ).  Entries to reduce the account amount reported in Worksheet 1 must be entered as a minus amount.
If the adjustment reported on Worksheet 1-B is based on revenue received from the sale of a service or item, the adjustment to reduce costs in Worksheet 1 should be in that specific cost center in which the cost of the service or item is reported.  Use the specific Account Reference # if available; otherwise, use the miscellaneous line.  If miscellaneous base and support are both available, use miscellaneous base cost account reference #.

Normally the sum total of adjustments to expenses is a negative amount.  If the sum total is a positive amount, a validation error message will occur.  The purpose of the message is to alert the preparer to verify the adjustment amounts have been properly entered in Worksheet 1-B.

Adjustments To Remove Special Services Costs

The cost of certain special services that are not considered part of the Medicaid Program routine nursing care per diem cost may be removed from total costs.  The removal of the cost from the facility total costs removes the cost allocation requirement of administrative costs to those services for which the nursing facility is limited to recovery of the direct cost of providing the service.  The cost of these services may be adjusted on Worksheet 1-B to exclude these costs from the administrative cost allocation.  The adjustment will exclude the costs from being included in the accumulated cost statistical basis used in the Worksheet 2 cost allocation.  If the nursing facility recovers revenue in excess of the direct cost of the services the adjustment of cost on Worksheet 1-B may be based on the revenue dollar amount received.  The revenue amount exceeding the direct cost will be considered the “overhead expense” that should be reflected as an adjustment to the “Miscellaneous expense” in the Administrative and General cost center.  This adjustment is in addition to the adjustment to exclude the direct cost of the service.  This adjustment process applies only to the service items where the billing process for those services is limited to recovery of the direct cost of the service.  Certain pharmacy services and Clintron bed costs are examples of this type of service.  This process may not be applied to other services activity if that particular activity normal billing process or practice includes billing of overhead or mark up costs.  

Automatically Entered Adjustments

The following adjustments are automatically entered by the cost reporting format for compliance with Medicaid reimbursement policies.  Any remaining cost in the identified accounts after reclassifications and adjustments will appear as a Worksheet 1-B adjustment to “zero” out the account.

Account Reference #156 -
Owner/Administrator compensation in excess of Medicaid guidelines from Worksheet 1-F.

Account Reference #123 -
Other non-allowable costs from Worksheet 1-D and Worksheet 1.

Account Reference #199 -
Penalties on Worksheet 1.

Account Reference #201 -
 Bad debts on Worksheet 1.

Account Reference #203 - 
Quality Assurance Assessment – Long Term Care tax on Worksheet 1.

Account Reference #207 -
Quality Assurance Assessment – Hospital (non–Long Term Care) tax on Worksheet 1.
Account Reference #208
Quality Measure Initiative Assessment – Long Term Care tax on Worksheet 1.

Account Reference #747
Medicaid Routine Care Unit #1 – Miscellaneous Base
Account Reference #192, #217, #257, #284, #312, #347, #369, #393, #419, #445, #473, #499, #518, #537, #555, #572, #592, #611, #628, #643, #661, #686, #714, #741, #768, #795, #822, #848, #874, #900, #926, #981 — Minor Equipment More Than $5,000 on Worksheet 1.  The appropriate depreciation and capital asset cost entries must be made on Worksheet 3, Statement of Capital Asset Values on Financial Records of Nursing Facility in order to properly report these items for Medicaid reimbursement.

Enter all of the text information on the same line as the adjustment dollar and account reference information.  Entry of text information on multiple lines will cause a validation error because there are no dollar or account number entries to correspond with the additional text lines.

NOTE:
Preparers completing multiple cost reports with the same adjustment may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Adjustments”.
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Worksheet 1-C

Statement of Costs of Services from Related Organizations

The purpose of this worksheet is to identify the cost claimed for services and supplies furnished to or purchased by the facility from organizations related to the provider by common ownership, control, central or interlocking directorates. Expenses for such transactions should not exceed expenses for like items or services in an arms-length transaction with other non-related organizations, or the cost to the related organization, whichever is lower.

1. Related to the provider means that the provider to a significant extent is associated or affiliated with or has control of or is controlled by the organization furnishing the services, facilities or supplies. [Refer to 42 CFR, Sec. 413.157(b)(1)]

2. Common ownership exists when an individual or individuals possess significant ownership or equity in the provider and the institution or organization serving the provider. [Refer to 42 CFR, Sec. 413.157(b)(2)] For purposes of Worksheet 1-C, common ownership of 5% or more ownership or equity must be reported.

3. Control exists where an individual or an organization has the power, directly and indirectly, significantly to influence or direct the actions or policies or an organization or institution. [Refer to 42 CFR, Sec. 413.157(b)(3)]

4. Interlocking directorate refers to situations where entities are under the control of officers, directors or board of directors who are related by marriage or not necessarily by marriage, but become engaged or interrelated with one another.
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ITEM A. Related Organization Lease/Rental

This question is specific to costs claimed in Worksheet 1 that result from lease/rental agreement with related organizations.  A “yes” answer to this question requires completion of Items C and D of this worksheet and Worksheet 1-D.

ITEM B. Related Organization Other Costs

This question is specific to costs claimed on Worksheet 1 that resulted from business transactions, other than lease/rental, with related organizations.  A “yes” answer to this question requires further completion of Items C and D of this worksheet.

ITEM C. Interrelationship of Provider to Related Organization(s)

This item is used to show the interrelationship of the provider to organizations furnishing services, facilities or supplies to the provider.  The requested data relative to all individuals, partnerships, corporations or other organizations having either a related interest to the provider, a common ownership of the provider, or control over the provider as referenced above in section Worksheet 1-C, must be shown in columns 1 through 6, as appropriate.

· Column 1

If the symbols A, D, E, F, or G are entered in column 2, enter the name of the related individual in column 1.  If the symbols B or C are entered in column 2 enter the name of related company or organization in column 1.  Enter the name of the individual, organization or business entity (i.e.: related party), which owns, controls or has business association with the related party entity/organization that is providing the transaction services to the nursing home.

· Column 2

Enter the appropriate symbol that describes the inter-relationship of the provider nursing home to the related party listed in column 1. (Note: only one symbol should be identified.  If more than one interrelationship applies, enter the predominant relationship).

· Column 3

If the individual or entity identified in column 1 has a financial interest in the provider, enter in this column the percentage of ownership the individual or organization has in the provider.

· Column 4

Enter in this column the name of the related individual corporation, partnership or other entity/organization.

· Column 5

If the individual or entity/organization in column 1 has a financial interest in the related entity/organization, enter in this column the percentage of ownership in such organization.

· Column 6

Enter in this column the type of business in which the related entity engages (e.g., medical drugs and/or supplies, laundry and linen service).
NOTE:
Preparers completing multiple cost reports with the same related organizations may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Related Organizations”.

ITEM D. Related Organization Cost Data

The purpose of this section is to determine cost adjustments to Worksheet 1, necessary to report expenses in accordance with the limitation identified in the Worksheet 1-C instructions, above.

Lines 1 and 2 are specifically identified for lease/rental costs, if applicable. Columns 1 through 5 identify the costs reported in Worksheet 1.  The data entered on this page relative to related party leases is informational.  No adjustments to expenses is made from this worksheet for underlying costs of such leases.  Providers with related party leases must complete Worksheet 1-D and must report the lease expense and resulting adjustments on that worksheet.

Lines 3 through 39 are open for the provider to enter the information relative to services and goods purchased from a related entity or party.  Columns 1 through 5 relate to information where such costs were claimed on Worksheet 1.  Briefly describe in column 1 the expense item or services purchased.  Column 2 is the reference to the Item C information row(s) that identifies that "related organization" for that expense.

Column 6 identifies the allowable costs applicable to services, facilities and supplies furnished to the provider by the related organization.  These costs must not exceed the amount a prudent and cost-conscious buyer would pay for comparable services, facilities or supplies that could be purchased elsewhere.

Column 7 reflects the adjustment, by Account Reference #, necessary to Worksheet 1 reported costs.  The amount in column 7 is automatically calculated and entered in Worksheet 1.

Note:
Services purchased from a related party or entity are viewed the same as unrelated party purchases as to the consideration of base and support account classifications.  If the purchased services from the related party are a purchased service cost that was split between base and support on Worksheet 1, two lines must be used on Worksheet 1-C for the purchased service to maintain the allocation of base and support cost and adjustment thereto.  For example, if laundry contracted services was originally entered in line 253 and automatically split between lines 252 and 253, adjustments must be made to both lines 252 and 253.

Providers that have costs allocated from a home office operation or purchases of management services, laundry, or any other type of services from a related party entity/organization must prepare and file detailed supporting documentation identifying these expenses and the allocation basis to the individual nursing facility (ies).  The required cost report format is the Michigan Medicaid Electronic Home Office Cost Statement, Form MSA–1578.  Where the expense allocated to the facility as on Schedule H of the Home Office Cost Report is then reported on the individual facility cost report  to several different accounts or cost centers, a cross walk must be included with the cost report submission.
NOTE:
Preparers completing multiple cost reports with the same related organization expenses may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Related Organization Expenses”.
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Worksheet 1-D

Statement of Leased Capital Assets

The purpose of this worksheet is to identify all lease expenses including pass-through leases reported on Worksheet 1.

ITEM A. Leased Capital Assets

This question is specific to costs claimed in Worksheet 1 that result from any lease/rental agreement.  A “yes” answer to this question requires completion of item B of this worksheet.
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ITEM B. Lease Rental Cost Incurred and Adjustment Required

This section provides for the determination of the necessary adjustments to lease/rental costs reported on Worksheet 1. 

The reporting in the first row is applicable only to those providers which are leasing the facility.  For facility leases, the “Name of Lessor” will automatically flow from the WS 1 – D to the WS 3 – Lessor.  

Enter the following information for each individual lease arrangement:

Identify the Lessor’s information.  Enter the appropriate information in each of the first three cells for each lease arrangement.  Entries can be of any length.  Although it may not print, the information is available electronically.  An entry of “Various” or leaving any of the cells blank is not proper disclosure, and will cause return of the cost report.
	Account #
	Procedure

	118
	Enter the dollar amount of the lease expense for the specific identified lease recorded in the providers’ accounting general ledger.

	119
	Enter the dollar amount of the underlying allowable depreciation expense incurred by the Lessor.

	120
	Enter the dollar amount of the underlying allowable interest expense incurred by the Lessor.

	121
	Enter the dollar amount of the underlying allowable property taxes expense incurred by the Lessor.

	200
	The “Miscellaneous” is a calculated field.  Completion of the separate “Miscellaneous Lease Expense” table, individually listing each account name/number and expense dollar amount which equates to the total miscellaneous expense.  Examples would be entering the dollar amount of the allowable Lessor’s repair costs, maintenance expense, insurance, etc. 

	122
	Lease Rental Component - Minor Equipment Leases.

The Medicaid Program allows certain minor equipment leases as pass through plant costs without adjustment to underlying costs.  Reference should be made to the Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix, Section 8.9.C and applicable policy bulletins for such items.  Such leases should be reported on Worksheet 1-D.  Enter the same amount to Account Reference # 122, Lease Rental Component. Account Reference # 123 will equal “0”.

	123
	This amount will be automatically calculated as the difference between Account Reference # 118 and the sum of Account Reference # 119, 120, 121, 200, and 122.


Enter description of item(s) leased.  Entries can be of any length.  Although it may not print, the information is available electronically.  An entry of “Various” or leaving any of the cells blank is not proper disclosure, and will cause return of the cost report.

The sum of the individual Account Reference # amounts for all leases will be automatically calculated and entered in the “Totals” cells on this worksheet.  These totals will flow to Worksheet 1-A and then to Worksheet 1 automatically.

A lease of any facility asset, which meets any of the conditions in CMS Pub. 15–1, Section 110.B.1.b establishes the lease agreement as a virtual purchase.  The lease of a facility asset must be considered and treated, for Medicaid cost reporting, as a virtual purchase if any of the conditions set forth in CMS Pub. 15–1, Section 110.B.1.b is satisfied.  This is applicable to assets that meet the Medicaid definition for treatment as a “pass–through” lease asset(s) and “non–pass through” leased asset(s).

NOTE:
Preparers completing multiple cost reports with the same non facility lease arrangements may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Non Facility Lease Arrangements”.
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Worksheet 1-E-1

Salary Information of Owners, Officers, Administrators, and Department Heads

The purpose of this worksheet is to identify the individuals working in the position of Owners, Officers, Administrators, and Department Heads and report their salary, wages, and hours for actual payroll hours within the specific nursing or service area or cost center in accordance with the column heading.  The worksheet should be completed from the facility’s accounting and payroll records.

If the facility maintains one salary and wage account or has various cost center payroll data combined for accounting purposes, the payroll data must be separately identified on Worksheet 1–E–1 by each cost center as indicated.

If an identified cost center did not have an individual staffing the position during the reporting period, click the check box “I certify that the position was not staffed during the reporting period”.

Officers – if a “home office” cost report which includes the required supplemental schedule “Key Personnel and Salary”, will be submitted with the salary detail of officers reported on the schedule, then click the checkbox “I certify that the position was not staffed during the reporting period”.

Name of Individual – Enter the first and last name of the individual employed in the position during the reporting period.  If more than one individual, enter the name(s) of all employees that were employed in the position during the reporting period. 

Contract Service or Related Party – Enter “yes”, when a related party pays the individual’s salary and the salary has been reported on Worksheet 1–C, enter “no” when the salary amount reported for the individual was reported on the nursing facility’s records. 
Number of Hours Per Week Devoted to this Function – Enter the number of hours devoted to this position by each employee listed.  Do not make adjustments to the hours to account for “overtime hours adjustment” as requested for Worksheet 7 reporting.  The number of hours should be entered as a whole number.
Total Hours Worked Per Report Period – The number of work hours reported for payroll reporting for employees during the cost report time period.  This amount should correspond to the number of hours worked or the number of hours on which the employee payroll is determined.  Do not make adjustments to the hours to account for “overtime hours adjustment” as requested for Worksheet 7 reporting.  The number of hours should be entered as a whole number.

Months Worked Per Reporting Period – Enter the number of months each employee listed worked in this position during the reporting period.   The number of months should be entered as a whole number.

Total Salary Cost Per Report Period – The salary and wage amounts should agree with the general ledger since they automatically will be posted to Worksheet 1, via the Worksheet 1–E–1.  The entry should be a whole number.

Information from this worksheet will automatically flow to the appropriate line on Worksheet 1–F.  If the “Contract Service or Related Party” was answered “no”, then the information for that employee will automatically flow to the appropriate line on Worksheet 1-E.  

NOTE:
Preparers completing multiple cost reports with the same owners, and/or officers, and /or administrators may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Key Employee Salaries”.
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	Worksheet 1–E–1 is mandatory; therefore, mark the Completed box.


Worksheet 1-E

Statement of Salaries and Wages

The purpose of this worksheet is to report salary, wages, and hours for actual payroll hours within the specific nursing or service area or cost center in accordance with the column heading.  The worksheet should be completed from the facility’s accounting and payroll records.

The records necessary to determine the appointment of salary cost between two or more cost centers must be maintained by the provider and must adequately substantiate the method used to apportion the salary cost.  If the facility maintains one salary and wage account or has various cost center payroll data combined for accounting purposes, the payroll data must be separately identified on Worksheet 1-E by each cost center as indicated.

The wage and salary information for Owners, Officers, Administrators, and Department Heads is reported on Worksheet 1 – E – 1 and will automatically flow to the appropriate cells on this worksheet (see above).  

Total No. of Staff – The number of staff should be reported in this column as numeric entry.  The entry should be a whole number.  The entry should not be the number of full time equivalence staff employed during the reported period.

Total Hours Worked Per Report Period – The number of work hours reported for payroll reporting for employees during the cost report time period.  This amount should correspond to the number of hours worked or the number of hours on which the employee payroll is determined.  Do not make adjustments to the hours to account for “overtime hours adjustment” as requested for Worksheet 7 reporting.  The number of hours should be entered as a whole number.

Total Salary Cost Per Report Period – The salary and wage amounts should agree with the general ledger since they are automatically posted to Worksheet 1.  The entry should be a whole number.
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	Worksheet 1-E is mandatory; therefore, mark the Completed box.


Worksheet 1-F

Salary Information of Owners, Administrators, Officers, Assistant Administrators and Relatives

The purpose of this worksheet is to identify the reported compensation applicable to owners, administrators, officers, assistant administrators and relatives to the owner.  The worksheet provides for the computation of any needed adjustments to these costs for amounts reported in excess of compensation limits allowed under the Medicaid policy.

The information required on this worksheet must provide for, in the aggregate, owners, administrators, officers, assistant administrators total compensation paid for the services, furnished in determining the reasonableness and allowable costs under the Medicaid guidelines.  Compensation includes:

1. Salary amounts paid for managerial, administrative, professional, and other services.

2. Amounts paid by the facility for the personal benefit of the owner to the extent the cost is allowable as salary and wages.

3. The cost of assets and services which the proprietor receives from the institution.

4. Deferred compensation. (Refer to 42 CFR, Sec. 413.102).

5. Directors’ fees paid.

Do not enter text or symbol information in the hours cells.  If it is necessary to enter text information to explain the individual’s employment status or other pertinent data, enter the text in the job description cell in the line (row) for that individual.

Maximum Medicaid owner/administrator compensation amounts applicable to nursing care facilities will be automatically be automatically entered, after the completion of Worksheet B and selecting the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list or clicking the “Calculate” button on the menu bar.  The maximum compensation limit is based upon the number of "available beds" for nursing care in the facility. 

If the facility has a Medicaid Program non-available bed plan or an Building Program Agreement in effect for the entire cost reporting time period or has operated under a ban on admissions for the entire cost reporting time period, the reduced number of beds available for nursing care must be considered.  The appropriate compensation limit is the limit corresponding with the highest number of "available beds" for any specific date during the subject cost report period. 

If the subject cost reporting period is less than twelve months, the compensation limit must be prorated to reflect the limitation for less than a full year.  The prorated amount is automatically calculated and equals:  (number of days in the cost report period divided by the annual days – 365 days or 366 days in a leap year) times the respective facility bed size compensation limit amount.
A proration of the compensation limit must also be made if the Administrator duties are being performed less than 40 hours per week.  The prorated amount is equal to: (total hours per week reported divided by 40 hours) times the respective facility bed size compensation limit amount.
Amounts in excess of the limit will automatically be adjusted on “Adjustment to Compensation” like and posted to Worksheet 1-B.

· Section I, II, III, and IV.

The name of the individual(s)and their respective salary amount reported on Worksheet 1–E–1 are automatically forwarded to the appropriate columns on Worksheet 1–F.  For each individual listed, the number of hours devoted weekly to this function, their job title and description, and other compensation amounts, if applicable, must be reported on this schedule.

· Section V.

The name of individual(s) employed in and / or paid by the facility whom are owners and / or relatives of facility ownership and their respective salary amounts, earned from non administrative duties and other compensation received must be reported in this section.  For each individual listed in this section, in addition to reporting their salary and other compensation, the number of hours devoted to this function, the job title and description, must be identified on this schedule.
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	Worksheet 1-F is mandatory; therefore, mark the Completed box.


Worksheet 1-G

Employee Health & Welfare Base/Support Reclassifications
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	NO MANUAL ENTRIES CAN BE MADE IN THE WORKSHEET 1-G.



This worksheet allocates those Employee Health & Welfare Benefits which are not directly identified to the appropriate account reference # (i.e., Employee Health & Welfare account lines 139 through 141 and 143 through 146).  The reclassification to the appropriate account reference # is computed automatically using the adjusted salaries from Worksheet 1.

Worksheet 2

Cost Allocation:  Statistical Basis
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	ALL FACILITIES ARE REQUIRED TO USE THE STEP-DOWN PROCESS.


Worksheet 2 provides for the proration of statistical data needed to equitably allocate expenses of the general service cost centers through the remaining cost report worksheets where necessary.

Cost Allocations

The Medicaid Program for long term nursing care reimbursement includes determination of reimbursement rates based on various cost categories.  It is necessary to separate the allocation of costs by “Plant cost (1, 2, and 3),” “Base Cost” and “Support Cost” categories as defined in the completion of worksheet 1 and related worksheets.  This separation is required to preserve the identification of the “type” (Plant, Base and Support) of cost in the total costs allocated to the facility’s revenue producing cost centers.

The provider should contact the Medicaid intermediary regarding the necessary worksheet preparation if further clarification is needed for cost finding statistics.  A written request must be made to the Financial Operations Administration, LTC Reimbursement and Rate Setting Section (RARSS), for approval of any deviation from prior approved cost finding statistics.  The written request must be made prior to the beginning of the cost reporting period in which the change is to apply. . (See CMS Pub. 15-1, chapter 23 for adequate cost data and cost finding and Section 9.6.B of the Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix.)

A written explanation and supporting documentation (if applicable) of any changes (except the statistical basis, see above); to the statistics used in the prior cost reporting period must be submitted with the cost report.  Examples would include:  remeasurement of the facility square footage, weighted average square footage, square footage changes due to renovation or new construction, the elimination of a cost center.

The Worksheet 2 series of cost reporting schedules provide for the allocation of total expenses of each general service cost center to those cost centers which receive the services.  These worksheets also provide for presentation of statistics used for allocating costs and automatically perform the mathematical calculations of the allocation process.  The cost centers serviced by the general service cost centers include all cost centers within the provider organization; that is, other general service cost centers, ancillary cost centers, inpatient routine service cost centers, out-patient service cost centers and other reimbursable cost centers and non-reimbursable cost centers.  These forms include the step-down method of cost finding for the allocation of the cost of services rendered by each general service cost center to other cost centers which utilize such services.  Once the costs of a general service cost center have been allocated, that cost center is considered “closed.”  Being “closed” it will not receive any of the costs that are subsequently allocated from the remaining general service cost centers.

The statistical basis shown at the top of each column on Worksheet 2 is the approved statistical allocation basis for the cost center indicated for each provider.    For each cost center a drop down listing shows all of the available approved alternative statistical bases.  The Provider must have prior approval to use an alternative basis (see above).    The Menu option “Tools” drop down option “Validation” will verify that the alternative statistical basis selected has been approved for the provider.  Most cost centers are allocated on different statistical bases.  However, for those cost centers where the basis is the same (e.g., square feet), the total statistical base over which the costs are to be allocated will differ because of the prior elimination of cost centers that have been closed.  If the basis is the same, the statistic used in each cost center must be identical.
The Medicaid Nursing Unit % (percentage) is calculated by dividing the respective care unit line by the sum of Ancillary Service and Nursing Service Cost Centers (line 21 - 43).  This percentage is used in calculating the Medicaid Nursing Unit % on Worksheet 7, Wage Pass-Through Cost Reporting Summary.  The Medicaid Nursing Unit % reported in Column 4 is based on the same data as Column 5.

Special Note for Allocation Statistics for Plant 1 + 3 (column 1) and Plant 2 (column 2).

Line 8 - Plant Operations and Maintenance.  Enter the square footage applicable to the plant operations and maintenance cost center area in column 1 and 2 as applicable.  

Line 9 - Utilities.  If the facility does not operate its own utility power plant or building, do not enter any square footage statistic on line 9, columns 1 and 2.  If the facility has a separate building or physical plant area for utility production, then enter square footage of that building area on line 9, columns 1 and 2 as applicable.  This note does not apply to the Utilities statistic column.  Square footage statistics must be entered in that column.

On Worksheet 2, the appropriate cost finding statistics will automatically appear in the yellow shaded cells.  All cost center totals and unit cost multipliers will be computed automatically.

When using the same statistical basis, and same statistical amount for multiple cost centers, use the “Copy Column” button, under the “Cost Centers” heading: 
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The following dialog box appears:
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Click the drop down box, next to “Select the source statistic”.  
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Select from the drop down list, the cost center that the statistics has been previously entered.  Then check the cost center(s) where the statistic is to be copied to.  Click the “Copy Statistics” button.

For example, you can copy the square footage statistic entered “Plant 1 + 3” to “Plant 2”, “Plant Operations & Maintenance”, “Utilities” and “Housekeeping” by clicking “Plant 2”, “Plant Operation & Maintenance”, “Utilities” and “Housekeeping”.  After the “Copy Statistic” function has been completed, the statistic entered in any cell may still be edited.
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	Worksheet 2 is mandatory; therefore, mark the Completed box.
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Worksheet 2-A

Cost Allocation:
General Service Costs

Worksheet 2-B

Cost Allocation:
General Service Costs, Excluding Depreciation

Worksheets 2-A and 2-B provide for the allocation of expenses of each general service cost center to those cost centers that receive the services.  These worksheets are automatically calculated after completion of Worksheet 2 by calculating the cost report.  The calculations are made by multiplying the unit cost multiplier times the applicable statistical unit for each respective cost center.

Worksheet 2-C

Computation of Inpatient Base Cost

Worksheet 2-D

Computation of Inpatient Base Cost, Excluding Depreciation

Worksheets 2-C and 2-D are provided to compute the amount of allocated base costs that are part of the general inpatient routine service cost.

Only the general service cost centers and general inpatient routine service cost centers are displayed because they are the cost centers needed in determining the base cost applicable to general inpatient routine service cost centers.  These worksheets provide for the computation of the allocated base costs utilizing the unit cost multipliers and cost finding statistics from Worksheet 2.  These worksheets were automatically calculated after completion of Worksheet 2 by calculating the cost report.

Worksheet 2-E

Computation of Inpatient Plant Costs

Worksheet 2-F

Computation of Inpatient Plant Costs, Excluding Depreciation

Worksheets 2-E and 2-F are provided to compute the amount of allocated plant costs that are part of the general inpatient routine service cost.

Only the general service cost centers and general inpatient routine service cost centers are displayed because they are the cost centers needed in determining the plant cost applicable to general inpatient routine service cost centers.  These worksheets provide for the computation of the allocated plant costs utilizing the unit cost multipliers and cost finding statistics from Worksheet 2.  These worksheets were automatically calculated after completion of Worksheet 2 by calculating the cost report.

Worksheet 2-G

Determination of Support Costs:  Per Patient Day Costs and Support/Base Cost Ratio

Worksheet 2-G calculates the support costs, per patient day costs, and support to base ratio as defined per Medicaid reimbursement policy.  Completion of this worksheet utilizes the information from Worksheets 2, 2-A, 2-C, and 2-E.  These worksheets were automatically calculated after completion of Worksheet 2 by calculating the cost report.

Worksheet 2-H

Determination of Support Costs:  Per Patient Day Costs and Support/Base Cost Ratio, Excluding Depreciation

Worksheet 2-H calculates the support costs, per patient day costs, and support to base ratio as defined per Medicaid reimbursement policy.  Completion of this worksheet utilizes the information from Worksheets 2, 2-B, 2-D, and 2-F.  These worksheets were automatically calculated after completion of Worksheet 2 by calculating the cost report.

Worksheet 3

Statement of Capital Asset Values

Capital Asset Values — General

Worksheet 3 series schedules are provided to identify capital asset value information necessary for the plant reimbursement determinations for the Medicaid Program.  Capital asset values will be allocated to the appropriate cost center serviced by such assets.

The capital assets owned by the facility are reported on Worksheet 3, Statement of Capital Assets Values on Financial Records of Nursing Facility.  The capital assets leased by the facility are reported on Worksheet 3-Lessor, Statement of Capital Asset Values on Financial Records of Lessor.  Either one or both worksheets may be applicable.

Costs in Minor Equipment - More than $5,000 accounts will automatically be adjusted out of Worksheet 1 through the use of a Worksheet 1-B adjustment.  The asset acquisition cost and depreciation must be reported in the appropriate asset section of Worksheet 3. 

If an asset is being leased, and the lease meets the criteria as a virtual purchase as described previously (see Worksheet 1–D instructions) and the lessee becomes the owner of the leased asset, the historical asset cost of the asset is determined by the sum of the asset’s original fair market value, plus any deferred charges (if applicable) less the annual lease rental expense claimed.  The asset year of acquisition is the current year.

Entering Capital Asset Values

Enter the data in yellow shaded cells.

Worksheet 3, Sections A, B, C, and D provide for the detailed identification of capital asset values by asset category, acquisition cost of such assets, activity relative to asset disposition and depreciation.  If there are no assets in the asset category, a zero (0) must be entered in the “Asset Cost Beginning Balance” cell.  After a zero (0) is entered in the cell, a “-” will appear in the cell.

Separate sections of Worksheet 3 exist for reporting the following asset cost categories: Land, Land Improvements, Building, Building Improvements, Leasehold Improvements (Building), Departmental Equipment, Furniture and Fixtures, and Transportation.

· Section A

Asset Cost Beginning Balance and Asset Cost Ending Balance

For the purpose of reporting asset value data for the current reporting period.  Enter the beginning balance for each asset cost category.  The beginning balance (for an ongoing provider) for each asset category must agree with the ending balance of the prior cost reporting period.  IF the provider does not have assets in any asset category, a beginning balance of “0” MUST be entered.  In the first reporting period by a new ownership of the asset cost categories, the asset’s beginning balance is the Medicaid allowable purchase values.  The dollar amount of asset costs reported in Section A must be the allowable cost basis of the asset for Medicaid Program reimbursement.  The "ASSET COST BEGINNING BALANCE" beginning balance in the current cost report period should equal the Section A, "ASSET COST ENDING BALANCE" for the prior cost report period.  The "ASSET COST ENDING BALANCE" is an automatic calculated amount. 

The Asset Cost Ending Balance is calculated as follows:

Section A, "ASSET COST BEGINNING BALANCE" 

plus 
Section A, "NEW ASSET ACQUISITION ALLOWABLE COST TOTAL" 

minus 
Section A, "PRIOR ASSET ACQUISTION ALLOWABLE COST TOTAL".

New Asset Acquisition and Prior Asset Acquisition

For new asset acquisition, first enter an identifiable description.  Enter the four digit year of the current cost reporting period end date in which the asset was placed into service.  For example: A provider with a June 30, 1999 fiscal year end, would use ‘1999’ for all assets placed into service between July 1, 1998 and June 30, 1999.  If the asset acquisition represents a replacement of a prior asset, enter the original acquisition year (four digit entry – see previous example) and allowable cost of the replaced asset.  Assets disposed of during the current reporting period but not replaced would also be included in this area.  If the cost reporting period is the final cost report period for a terminating provider, only those assets disposed during the reporting period are reported.  Do not report the asset values of those assets which are included as a part of the sales transaction.  Enter in the “Notes” any additional information regarding this asset transaction.  Numeric entry data is required in the amount columns.  Do not use symbols or text in the amount columns.  See the related “Asset Cost Reporting and Marshall Valuation Index” cost reporting instructions for asset disposals.  
Each row, the “Replacement Asset” column will default to “yes”.  If the asset acquisition is not a replacement asset, select from the drop down list in the “Replacement Asset” column “No”.

Entry of data in a row will automatically add a new additional row, up to 250 rows.
Facility Innovative Design Supplement (“FIDS”) Asset Acquisition and Disposals
Asset acquisitions for qualifying FIDS projects must follow the above instructions related to the reporting of asset acquisitions.  If the FIDS asset acquisition represents a replacement of an existing facility asset, enter the original acquisition year and allowable cost of the replaced asset.  If the allowable cost of the replaced or disposed asset cannot be identified, see the related “Asset Cost Reporting and Marshall Valuation Index” cost reporting instructions.  Enter in the “Notes” column, “FIDS” and any additional information regarding this asset transaction.
This data should only reflect the allowable cost of the purchase in accordance with Federal regulations 42 CFR 413.13(b). (Provider Reimbursement Manual, CMS Pub 15-1, Part I, Section 104)

· Section B

The purpose of Section B is to report asset cost information only for those assets reported in the facility financial records at a value that is not equal to the Medicaid Program allowable value reported in Section A of the worksheet.  Adjustments are required if the provider has recorded asset values on the facility’s financial records that are different from those values reported in Section A. 

The dollar amounts reported on the first line of the Section should be the Section B ending "TOTALS" from the prior cost report period.  The first line description column indicates that these amounts are the beginning balances carried over from prior period reported adjustments, and no entry is required by the preparer.  The "code" column has been entered "b" as a standard entry and no entry id required by the preparer.  Enter the amounts in the yellow cells under the "ASSET COST PER FIN. REC. BALANCE" column and "MEDICAID ALLOWABLE COST BALANCE" column first line as applicable.  If there are no previous period adjustment amounts, the entry may remain blank or a zero may be entered.  

The remaining rows in this section are for reporting adjustments applicable to new asset acquisitions that are reported for the current cost report period.  Briefly describe the type of assets involved and the nature of the adjustment in the “DESCRIPTION” column.  Enter the code as indicated on the worksheet.  Enter in the “ASSET COST PER FIN. REC. BALANCE” column and “MEDICAID ALLOWABLE COST BALANCE” column the appropriate amounts.

Examples of asset cost entries in Section B are:

a) The cost of an asset continues to be reported in the facility financial records but a portion or all of cost of that asset has been reported in the Section A, "PRIOR ASSET ACQUISITION" category (a roof replacement).  The financial statement asset value is reported in the "ASSET COST PER FIN. REC. BALANCE” column.  The amount entered in "MEDICAID ALLOWABLE COST BALANCE” column will be zero.

b) The cost of an asset reported in the facility financial records exceeds the dollar amount of that asset item reported in Section A.  The amount reported in the "ASSET COST PER FIN. REC. BALANCE” column will equal the value of the asset in the facility financial records; the amount entered in "MEDICAID ALLOWABLE COST BALANCE" will be equal to the "NEW ASSET ACQUISITION" amount reported for that asset item in Section A.

c) The cost of an asset does not appear in the facility financial records as an asset, however a "NEW ASSET ACQUISITION" amount has been reported in Section A for that asset item (asset purchase that was expensed in the facility financial records, but the asset cost must be reported as a capital asset expenditure for the Medicaid Program).  The entry in the "ASSET COST PER FIN. REC. BALANCE” column is zero; the amount entered in the "MEDICAID ALLOWABLE COST BALANCE" column will equal the "NEW ASSET ACQUISITION ALLOWABLE COST" amount reported for that asset item in Section A.  It should be noted that if a cost is reported as an asset on the facility financial records, it must be reported as a capital asset for the Medicaid Program.
The Section B "TOTALS" line is the sum of the first line amount (which is the prior year cumulative amount) plus the current cost report period reported amounts.  This "TOTALS" line should be the first line entry amounts in Section B of the subsequent cost report period cost report.

Innovation Award Asset Purchases.  Report the dollar amount of the capital asset cost recorded in the facility financial records in the "ASSET COST PER FIN. REC. BALANCE” column.  The dollar amount entry in the "MEDICAID ALLOWABLE COST BALANCE" column must equal the dollar amount reported in Section A for that asset item during a prior reporting period.  If the asset allowable cost is greater than the Innovation Award revenue amount, enter the dollar amount in excess of the revenue amount.  This latter amount should be equal to the amount reported in Section A for the asset item.

· Section C

The beginning and ending balances will be automatically calculated and agree with the historical cost asset values reported in the facility financial statement.

The “Asset Cost Beginning Balance” amount is calculated as follows:

Section A, "ASSET COST BEGINNING BALANCE" 

plus 
Section B, first line entry amount "ASSET COST PER FIN. REC. BALANCE" 

minus 
Section B, first line entry amount "MEDICAID ALLOWABLE COST BALANCE" 

equals 
Section C, "ASSET COST BEGINNING BALANCE".

The “Asset Cost Ending Balance” amount is calculated as follows:

Section A, "ASSET COST BEGINNING BALANCE" 

plus 
Section A, "NEW ASSET ACQUISITION ALLOWABLE COST TOTAL" 

plus 
Section B, "ASSET COST PER FIN. REC. BALANCE TOTAL" 

minus 
Section A, "PRIOR ASSET ACQUISITION ALLOWABLE COST TOTAL" 

minus 
Section B, "MEDICAID ALLOWABLE COST BALANCE TOTAL" 

equals 
Section C, "ASSET COST ENDING BALANCE".

NOTE:  The ending asset values of Section C must agree with the asset values reported on Worksheet 5.
· Section D

Provided for reporting of allowable asset depreciation.  This section must be completed based on asset depreciation as an allowable cost item in accordance with Medicaid Program allowable cost principles.  Complete the lines in accordance with line descriptions.  The “Prior Years Asset Purchases” column is used for reporting current period depreciation relative to assets purchased in reporting periods prior to the current cost reporting period.  The “Current Year Asset Purchases” column is used for reporting current period depreciation relative to new assets purchased in the current reporting period.  The “Adjustment to depreciation reserve for asset disposals” line is used to record any adjustment necessary to correct the accumulated depreciation reserve balance for that asset category.  The amount in the “sum” column for the “Current year depreciation” line automatically will flow to Worksheet 1, Plant Costs, account reference # 130, 131, or 132 dependent on the asset category.  


The “sum” column for the “depreciation reserve ending balance” line is calculated as follows:

“Depreciation reserve balance beginning of year” SUM column amount

plus
“Current year depreciation” SUM column amount

plus
“Adjustment to depreciation reserve for asset disposals” SUM column amount

equals
“Depreciation reserve ending balance” SUM column amount.
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	Worksheet 3 is mandatory; therefore, mark the Completed box.


Worksheet 3-Lessor

Statement of Capital Asset Values - Lessor

This Worksheet should not include any minor equipment leases (expensed) or pass-through leases. 

Note:
For any facility lease, the name of the lessor will flow automatically after completion of Worksheet 1 – D.

Note:
Section D is not applicable because depreciation is not reported in this worksheet since it has been previously reported in Worksheet 1 – D.

· Section A

In addition to the instructions above for Worksheet 3 Section A, the four digit calendar year the lessor purchased the facility assets must be included for Land, Land Improvements, Building, and Building Improvements. 

· Section B and C 

Follow the corresponding instructions above for Worksheet 3, Statement of Capital Asset Values.
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	Worksheet 3-Lessor is NOT mandatory. Mark the Completed box if you have entered data; if there are no entries, mark the Not Applicable box.


Worksheet 3-A

Statement of Directly Identified Asset Values

Worksheet 3-A is for the purpose of allocating allowable asset values reported on Worksheet 3, to applicable cost centers.  This data will be carried forward to Worksheet 3-B for the allocating of asset values to cost centers.  The information is necessary for determining Medicaid reimbursement “return on current asset value” portion of the plant cost component.

The totals from Worksheet 3 series will automatically flow to Worksheet 3-A by asset category to line 41 C by selecting the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list.  Those asset values that can be directly identified to an individual cost center should be entered in the yellow shaded cells.  Line 1 can be calculated by use of the Select the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list, after directly identified assets have been entered.

The provider must directly allocate those new assets that be identified to a specific cost center to the appropriate cost center.  An on–going provider must continue to directly allocate assets, which were directly allocated on a prior period’s cost report in subsequent cost reporting periods.
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	Worksheet 3-A is mandatory; therefore, mark the Completed box.


Worksheet 3-B

Allocation of Capital Asset Values and Determination of Relative Percentages
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	NO MANUAL ENTRIES CAN BE MADE IN WORKSHEET 3-B.


Worksheet 3-B provides for the allocation of capital asset values to those cost centers which utilize such assets.  Capital asset values will be allocated to specific cost centers.  The cost centers utilizing such assets include all cost centers within the provider organization; that is, other general service cost centers, ancillary cost centers, inpatient routine cost centers, outpatient service cost centers, other reimbursable and non-reimbursable cost centers.  The main objective of this worksheet is to determine the relative percentages of asset values applicable to the cost centers.  The cost finding statistics flow from Worksheet 2.  This worksheet was automatically calculated after completion of Worksheet 2 and Worksheet 3 by calculating the cost report. 

Worksheet 4

Apportionment of Ancillary Services to Health Care Programs

Worksheet 4 is provided for the reporting of nursing facility ancillary services cost to the Medicaid Program.  The cost data for those services cost settled by the Medicaid Program will be utilized in the cost settlement determination. Services reimbursed by the Medicaid Program on a “fee for service” basis are not subject to cost settlement.  Refer to the Medicaid policy manual for ancillary service reimbursement policies.

· Column 1

“Charges” automatically flow from Worksheet 1 and column 1 “costs” flow from the Worksheet 2-A.

· Column 3

The amount of gross charges for Medicaid inpatient services of that cost center.

· Column 4

The amount of gross charges for Medicaid outpatient services of that cost center.

The remaining cells will automatically be calculated by selecting the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list.
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	Worksheet 4 is NOT mandatory. Mark the Completed box if you have entered data; if there are no entries, mark the Not Applicable box.


Worksheet 5

Balance Sheet

Enter the balances recorded in the provider’s books of accounts at the end of the reporting period.  Dollar amount entries must be whole dollar amounts.  Do not enter cents.

The asset values reported on Worksheet 5 must agree with the ending asset values of Section C of Worksheet 3.  The Accumulated Depreciation expense reported on Worksheet 5 must agree with Section D, Depreciation Reserve Ending Balance, of Worksheet 3.
This worksheet must be completed or the facility must substitute prepared financial statements instead of preparing this worksheet; however, such statements must disclose the required data. 

The totals will automatically be calculated by selecting the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list.  
NOTE:
Preparers may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Balance Sheet”.
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	Either mark the Completed box or mark the Substitute box as applicable on Worksheet 5.




Worksheet 6

Determination of Average Borrowings Balance

The average borrowings balance worksheet is necessary for the Medicaid Program per diem rate determination of the plant cost component.  The data must cover the current cost reporting period coinciding with the cost report time period.  The data is coordinated with the interest expense determined allowable during the period.  The purpose of this worksheet is to coordinate borrowings balances with allowable interest expense.

The “Month Ending Dollar Balance Of Borrowings For The Time Period” columns must be completed for allowable interest bearing loans applicable to the nursing home operations.  The loan balances must be identified separately as to the liability on the facility financial records and liability on the financial records of a related party or lessor.

The month ending balances of only mortgages and loans for which interest expense is being claimed and is allowable must be shown on this worksheet.  If the provider or the other party has non-allowable borrowings, the non-allowable loan balance must not be included in the month ending balance amount.  If the Provider’s outstanding borrowing balance is totally zero for the entire cost reporting period, enter zero (0) in the “Beginning Balance” and “Month 1” lines in the “Facility Borrowings” and “Lessor Borrowings” columns.  This also applies if no interest cost is being reported applicable to the Medicaid nursing unit.
Enter each loan on a separate line in the appropriate section of Worksheet 6 (either “Facility Borrowings” or “Lessor Borrowings”.  Entry of loan information in row two, will create a new row in each section.  There is no limit to the number of additional rows that can be created.  
· Mortgage Balance

Include in this column the sum total of the month ending principle balance of the mortgage and land contract loan(s).

· Other Loans Balance

Include in this column the sum total of the month ending principle balance of loans other than those identified above.  These would include working capital loans, notes payable, equipment loans, vehicle loans, etc.

The month ending balance (of an ongoing provider) of the prior period cost report must equal the current cost report period's “Balance at Beginning of Fiscal Period” for each loan.  The month ending balances should be reflected as whole dollar amounts.  If the loan balance at the end of a month is zero, then “0” should be entered.  Entries should only be made in the "Balance beginning of fiscal period" line and the individual "Month (number)" lines that the cost report time period covers.  Example: if the cost report time period only covers a nine month time period, only enter amounts through "Month 9".  Do not make an entry in the line entitled "Month 13" unless this specific cost report is for a 13 month time period.
The “Portion Applicable to Nursing Home Operations” percentage automatically flows from Worksheet 3-B.

The Totals, Gross Average Borrowings Balance, Nursing Home Average Borrowing Balance will automatically be calculated by selecting the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list.  
NOTE:
Preparers may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Facility Borrowings – Other”.

NOTE:
Preparers may use the “import” function to complete this worksheet, see separate “IMPORT Instructions” document for instructions on how to “Import Lessor Borrowings – Other”.
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	Worksheet 6 is a mandatory worksheet for any provider that their license number is between “400” and “499”.  Providers that their license number is between “300” and “399” and “800” and “899” mark the Not Applicable box.


Worksheet 7

Wage Cost Reporting Summary

The purpose of the worksheet is to determine the cost of changes for wages, associated payroll costs, and benefits increases to routine nursing care unit employees and the amount of cost per inpatient day for these incurred cost changes for wages.  This accounting of payroll data is different than the payroll information presented in Worksheet 1-E.  This reporting is for purposes of evaluating wage rate levels of the routine nursing care unit employees.

Employee benefit cost increase is included only when there is an actual increase in the benefits available to employees or a decrease in the employee contribution to the cost of the benefit package.  Increased costs of existing benefit packages do not qualify.

The provider is required to complete the wage reporting documentation worksheet in accordance with Medicaid Program policy previously issued in Medical Services Administration Bulletin LTC 01-02.  Detail instructions and a facsimile worksheet for wage data reporting is provided in this bulletin based upon individual employee hours and wage compilation.  The nursing facility may elect to compile the data by individual employee or may report the data based on cost center aggregate wage data.  Effective with cost reporting periods that begin on or after October 1, 2000, an alternative wage data reporting method may be completed.  The nursing facility is not required to compile the supporting detail of hours and wages by individual employee.  Total employee hours and total wages may be reported for the entire cost center (employee group).  The aggregate average hourly wage will be determined from this data.  Regardless of the method selected for reporting the wage data, the same process must be utilized for both the benchmark time period and the cost report time period.

Salary and wage data of staff pertaining to the Nurse Aide Training and Testing Program must not be included in this wage data reporting.  Salary and wage data of staff related to the Nurse Aide Training and Testing Program is reported on Worksheet 8.

Two wage cost reporting summary worksheets are provided for those providers with two Medicaid certified routine nursing care units.  One worksheet must be completed for each Medicaid certified routine nursing care unit.  If the facility has only one Medicaid certified routine nursing unit, use the first format on the worksheet; and leave the second format blank.

Provider Information, Medicaid Provider Number, and Total Actual Patient Days flow from previous worksheets for the respective Medicaid certified routine nursing care unit.

PART I.

Benchmark Period

The established benchmark period will be automatically entered based upon completion of the cost report period on the Checklist (see the Checklist instructions).  Employee wage levels in the cost reporting period will be measured against the wage levels in benchmark period to determine the amount of change.  The benchmark period for each provider will be employee payrolls ending during the month of September preceding the begin date of the cost report time period (Example:  cost report period January through December 2002, benchmark month is September 2001).  Wages and hours information must be separately reported for each employee group identified by the various operations departments of the facility.  The objective is to measure the average hourly base wage rate for employee group during this time period.

Wages - Enter the dollar amount of gross wages paid to employees in the payrolls ending during the month.  This information will be primarily for September hours, however may include some hours from August due to payroll time periods extending beyond the last day of August.

Wage dollar amounts will include holiday paid wages, therefore it is important to also include the associated paid hours in the "Hours Paid" category.

Special attention is required in reporting wage dollar amounts for shift premium pay.  Reporting of shift premium pay must be on a consistent basis for both the benchmark period and cost reporting period.  The provider may choose either method of reporting of shift premium pay depending upon the availability of the individual nursing facility payroll reporting data:

1. Shift premium pay is excluded in the wage reporting for both time periods.  This is the recommended procedure since shift premium is not part of an employee's base wage rate.  Payment of shift premium during the wage period is not considered a wage increase.  Increased costs due to shift premium pay would only be considered wage increase if there were no shift premium pay program in the facility prior to the benchmark time period.  If such a program was implemented after the benchmark period, method 2 must be used and include the shift premium pay in the wage period wages. 
OR

2. Shift premium pay is included in the wage reporting for both time periods.  The inclusion of shift premium pay may adversely impact the measurement of average hourly wage depending upon the nursing facility employee staffing assignments.  Employees receiving shift premium pay in the benchmark period, but not in the pass-through period, or the reverse situation for employees not receiving shift premium in the benchmark period, but receiving it in the cost report period, would be impacted in the wage change measurement.  Consistency of reporting applies to all employees.  Shift premium pay reporting cannot be included for some employees receiving shift premium pay and not included for other employees who also receive shift premium pay in their wages.

Hours Paid - Enter the number of paid hours for the payrolls in the benchmark time period.  Paid hours are regular hours plus sick, vacation, or other leave paid plus overtime hours plus overtime premium hours.  (Example:  an employee is paid for 35 regular hours worked, 5 hours sick leave and 10 hours overtime at time-and-a-half, the hours paid for that employee are 55 hours.)

Average Hourly Rate - Calculated as indicated.  (NOTE:  In the electronic format, this is calculated automatically.)

Cost Reporting Period

Report this information on the basis for the complete cost reporting period.  Payroll information may be reported on the basis of payrolls ending during the cost reporting period if the nursing facility has maintained payroll time period reporting consistent with the previous year, or on the basis of paid hours and wages specific to the time period included in the annual cost reporting.  The data must be consistent reporting for all employee groups.

Wages - Enter the actual dollar amount of gross wages paid to the employees for the cost reporting time period.  Gross wages reporting must be consistent with the benchmark period wages reporting.

Hours Paid - Enter the actual number of paid hours for the reporting period.  Paid hours are defined in the same manner as the benchmark period.  Salaried employees are reported to a maximum of 2,080 hours, on an annual basis.  Salaried employees employed less than the full year are reported for the prorated number of hours corresponding with the employment period.

Average Hourly Rate Change - Calculated as indicated for each individual employee group identified. (NOTE:  In the electronic format, this is calculated automatically.)
Average Increase - Calculate for each individual employee group identified.  (Column F minus column C.)
Associated Cost - Calculated amount.  (NOTE:  In the electronic format, this is calculated automatically.)
New Benefits Per Hour – Cost incurred during the wage cost reporting year for new benefits must be determined if "new benefits" are being claimed for wage increase cost.  New benefits are items that were not provided to employees prior to the benchmark period.  Increased costs of existing benefits do not qualify.  Examples of new benefits would be: added health care insurance coverage with corresponding cost increase; additional paid time off; reduction in employees share of health benefit premium; day care services; etc.  The cost per employee paid hour should be reported in this column.  The aggregate average hourly cost of the new benefits may be used by employee group.

Total Per Hour - Calculated for each individual employee group identified.  (NOTE:  In the electronic format, this is calculated automatically.

GROSS - Calculate Per Class for each individual employee group identified.  (Column E times Column J).  (NOTE:  The maximum Gross per Class amount cannot exceed the reported hours paid times the maximum hourly wage increase – currently $0.50 per hour).

If the gross wage increase per employee group is determined from individual employee detail wage data, enter the sum total of wage increase for the respective employee group.

Note:
Wage and hours data reported for the employee groups for “Registered Nurses,” “Licensed Practical Nurses” and “Nurse-Aides” must only include the direct nursing staff for the respective Medicaid certified routine nursing care unit.

PART I. A

Wage change data applies to the employee wages applicable to routine nursing services.  Gross reimbursable wage amounts will automatically be allocated to the applicable Medicaid certified nursing unit. The allocation will reflect the relative proportion of the applicable employee group cost center that is attributable to the routine nursing unit through normal cost reporting allocations. 

Column M flows automatically from Worksheet 2, Medicaid Nursing Unit %.  Direct care nursing staff must be identified by unit on Worksheet 1-E, therefore these percentages are 100%.  (See Note above.)
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	Mark the form as “Completed” if wage data is being reported.  Mark the form “Not-Applicable” only if the provider is reporting that wage increases were not granted in the cost report period subsequent to the referenced benchmark time period.


Worksheet 8

Nurse Aide Training and Testing Program

The purpose of this worksheet is for the provider to access Medicaid Program reimbursement outside the routine nursing care rate per diem for OBRA nurse aide training and testing programs.  The worksheet must be completed as part of the annual cost report.  Costs will be retrospectively settled to reflect the Medicaid Program’s appropriate share of actual allowable training and testing costs.

Enter the following data in the yellow shaded cells:

· Date Training Program Began

Enter the date the facility began administering or participating in a Michigan Department of Licensing and Regulatory Affairs, Bureau of Community and Health Systems approved Nurse Aide Training Program.

· Questionnaire And Statistical Data

1. Number of Facility Staff Members
Enter the appropriate numbers of nurse aide/orderly student staff for each Training and Testing category during the cost reporting period identified above.

2. Medicare Program Certification

Answer as applicable.

3.
Mode of Training

It is possible that providers may utilize both in-house staff and outside contractors.  If a chain organization or group home ownership uses an approved central training program, indicate the training as “in-house” with the notation “centralized training”.  If multiple outside contractors are used, indicate each of them and the time periods utilized.

4.
Training Statistics

a) Training Staff Hours.  Indicate the work hours expended by training staff personnel for Bureau of Community and Health Systems approved nurse aide/orderly training programs.  This time may include direct class time and preparation time.

b) Student Staff Hours.  Indicate the work hours expended by nurse aide/orderly students while attending Bureau of Community and Health Systems approved nurse aide/orderly training programs.

3. Inpatient Days

This information automatically flows from Worksheet B. 

6. Lockout Facility

A facility identified by the Bureau of Community and Health Systems, as a “lockout facility” cannot conduct an approved training and testing program, cannot be a training/clinical practice site for another approved program and cannot conduct clinical skills testing.  The facility is notified of the lockout determination action by the Bureau of Community and Health Systems. Answer question as applicable. 

The provider must not report and make claim for Medicaid Program reimbursement on this schedule for any costs incurred and associated with providing training by the lockout facility during the lockout time period.  Nurse aide training program costs during the lockout time period are limited to the costs incurred in obtaining training and testing outside the facility from an approved nurse aide training program. 

· Cost Information

The specific allowable costs are described in the Items 1-7

The cost data entry for items 1 through 7 will automatically flow from the Worksheet 1 series.

· Item 8

Miscellaneous - Expenses incurred for an approved nurse aide training program cost that is not classified in cost categories items 1-7 explained above requires the completion of this section. 

A specific line has been established for reporting costs associated with original and biennial renewal Nurse Aide Registry fees paid by the facility for employees.  Nursing facilities are required to directly pay for each Nurse Aide’s biennial renewal registry fees.  See Medicaid Provider Manual, Nursing Facility Chapter, Cost Reporting and Reimbursement Appendix, Section 9.9.A. “Nurse Aide Competency Evaluation Program and Nurse Aide Registry”.
Enter the detail description and cost of these individual expenses, in the yellow shaded cells.  The total of these items will be automatically calculated by selecting the Menu Option “Tools” and then selecting “Calculate” from the “Tools” menu drop down list.  This total must equal the provider’s trial balance.  The total automatically will flow to Worksheet 1, Account Reference 964. 

· Item 9

Automatically completed when the cost report is calculated.

· Item 10

Training Program Equipment Use Allowance - An annual cost allowance is made for equipment purchased specifically for the Bureau of Community and Health Systems approved nurse aide training program.  Such equipment purchases are not included in the plant asset costs of the facility for routine nursing care.  An annual allowance of 15% of the equipment purchase price is reported as a cost of the training program, for as long as the equipment is used in the program, but not to exceed seven years. 

The use allowance is an annual percentage; therefore an adjustment is made to the 15% amount if the cost report period differs from 12 months.  Line 10.a. and Line 10.b. will automatically be calculated.  Enter line 10.c. equipment purchase cost as required in the yellow shaded cells. 

The remainder of the worksheet will be completed by calculating the cost report.

The “Medicaid Program Percentage” reflects Medicaid routine nursing care days divided by the total routine nursing care inpatient days in the facility as reported on Worksheet B. 
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	If the facility has not incurred any costs for this purpose, mark the Not Applicable box.  Mark the Completed box on Worksheet 8, if Nurse Aide Training costs ARE being claimed.








NEW 











NEW 








49
49

_1053231938.doc



